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Thank you for purchasing the CMC15G
Multifunction Gateway Communication
Controller.

This manual contains information for
ensuring the correct use of the
CMC15G. It also provides necessary
information for installation, mainte-
nance, and troubleshooting.

This manual should be read by those
who design and maintain equipment
that uses the CMC15G. Be sure to keep
this manual nearby for handy reference.



This product has been designed, developed and manufactured for general-purpose
application in machinery and equipment.

Accordingly, when used in applications outlined below, special care should be taken to
implement a fail-safe and/or redundant design concept as well as a periodic
maintenance program.

• Safety devices for plant worker protection
• Start/stop control devices for transportation and material handling machines
• Aeronautical/aerospace machines
• Control devices for nuclear reactors

Never use this product in applications where human safety may be put at risk.

RESTRICTIONS ON USE

NOTICE

©2008 Yamatake Corporation ALL RIGHTS RESERVED

Be sure that the user receives this manual before the product is used.

Copying or duplicating this user’s manual in part or in whole is forbid-
den. The information and specifications in this manual are subject to
change without notice.

Considerable effort has been made to ensure that this manual is free
from inaccuracies and omissions. If you should find an error or omis-
sion, please contact Yamatake Corporation.

In no event is Yamatake Corporation liable to anyone for any indirect,
special or consequential damages as a result of using this product.



Conventions Used in This Manual
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� To prevent injury to the operator and others, and to prevent property damage, the following types of safety

precautions are indicated:

� In describing the product, this manual uses the icons and conventions listed below. 

Use caution when handling the product.

The indicated action is prohibited.

Be sure to follow the indicated instructions.

Handling Precautions:
Handling Precautions indicate items that the user should pay attention to when
handling the CMC15G.

Note: Notes indicate information that might benefit the user.

: This indicates the item or page that the user is requested to refer to.

(1), (2), (3): Numbers within parentheses indicate steps in a sequence or parts of an
explanation.

[ABC] button: Indicates a selectable button on a personal computer screen.

[File], [Edit]: Indicates messages and menus displayed on the personal computer.

[AB] → [XYZ]: Indicates menu selection on a personal computer.

[Enter] key: Indicates keys on the keyboard.

[Shift]+[f.5] key: Indicates the operation of pressing the [f.5] key on the keyboard while the [Shift] key
is pressed.

>>: Indicates the result of an operation, details displayed on the personal computer or
other devices, or the state of the device after operation.

CAUTION Cautions are indicated when mishandling this product might result in

minor injury to the user, or only physical damage to the product.
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Safety Precautions

CAUTION
Use Yamatake Corporation's SurgeNon if there is the risk of power surges caused by light-
ning.
Failure to do might cause fire or faulty operation.

Prevent the total power consumption of all linked modules from exceeding 100W.

Before wiring, removing or installing the CMC15G, be sure to turn the power OFF.
Failure to do so might cause faulty operation.

Do not disassemble the CMC15G.
Doing so might cause faulty operation.

Use the CMC15G within the operating ranges (temperature, humidity, voltage, vibration,
shock, mounting direction, atmosphere, etc.) recommended in the specifications.
Failure to do so might cause fire or faulty operation.

Do not block ventilation holes.
Doing so might cause fire or faulty operation.

Wire the CMC15G in compliance with established standards, using the specified power source
and recognized installation methods.
Failure to do so might cause electric shock, fire or device failure.

Firmly tighten the terminal screws at the torque listed in the specifications.
Insufficient tightening of terminal screws might cause fire.

Do not use unused terminals on the CMC15G as relay terminals.
Doing so might cause electric shock, fire or faulty operation.

Do not allow lead clippings, chips or water to enter the CMC15G case.
Doing so might cause fire or faulty operation.

Do not short-circuit the batteries, and do not get them wet. If short-circuited, they may over-
heat or catch fire.

Do not throw used batteries into fire or discard them as general garbage. When discarding
them, follow local rules and regulations.

When disposing of the CMC15G, dispose of it appropriately as industrial waste in accordance
with local bylaws and regulations.



The Role of This Manual
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A total of four different manuals are available for the CMC15G. Read them as necessary for your specific require-

ments. If a manual you require is not available, contact Yamatake Corporation or its dealer.

User's Manual

CP-UM-5463JE

WARNING

CAUTION

WARNING

CAUTION

CMC15G Multifunction Gateway Communication Controller User's
Manual: "Insatallation & Configuration" Manual No. CP-SP-1277E

This Manual.

Personnel in charge of design, manufacture, operation, and/or maintenance
of a system using this unit must thoroughly read this manual.

This manual also describes the installation, wiring, connections for
communication, all functions and settings of this unit with the
GatewayEditor, operating procedures, troubleshooting, and specifications.

CMC15G Multifunction Gateway Communication Controller
Manual No. CP-UM-5463JE

This manual is supplied with the product. This manual describes the safety
precautions, installation and wiring.

CMC15G Multifunction Gateway Communication Controller User's
Manual: "Communications Connection" Manual No. CP-SP-1278E

Personnel in charge of combine the CMC15G with PLCs made by other
manufacturers and dedicated board computers to build systems must
thoroughly read this manual.

This manual describes how to connect to PLCs, address maps that
correspond to PLCs, and other operations and settings required for making
applications using PLCs.

CMC15G Multifunction Gateway Communication Controller User's
Manual: "Logging Function"

Manual No. CP-SP-1279E

Personnel in charge of design, manufacture, operation, and/or maintenance
of a system using logging function by CMC15GD001 advanced model must
thoroughly read this manual.

This manual describes detailed instructions on logging functions, details
about LogViewer.



Organization of This User's Manual
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This manual is organized as follows:

Chapter 1. OVERVIEW
This chapter describes the applications, features, model selection guide, and part

names and operation flow of the functions of the CMC15G.

Chapter 2. PART NAMES AND FUNCTIONS
This chapter describes the names and functions of parts on the CMC15G.

Chapter 3. MOUNTING
This chapter describes the environmental conditions and installation procedures

when installing the CMC15G.

Chapter 4. WIRING
This chapter describes the wiring procedures, wiring precautions, and connection

examples.

Chapter 5. BASIC FUNCTIONS
This chapter describes data transmission, module setup and internal event.

Chapter 6. LOGGING FUNCTION
This chapter describes logging function.

Chapter 7. EXTENDED FUNCTIONS AND OTHER FUNCTIONS
This chapter describes the extended function and the option configuration that is

functions other than the basic functions.

Chapter 8. GATEWAYEDITOR
This chapter describes the overview, the installation, the start, the end, and the

operation method of the GatewayEditor that is a set tool of the CMC15G.

Chapter 9. WORKING WITH GATEWAYEDITOR
This chapter describes a setting method and a set item to operate the CMC15G in

the GatewayEditor.

Chapter 10 CONNECTING TO THE CMC15G WITH GATEWAYEDITOR
When the GatewayEditor is connected with the CMC15G with USB, this chapter

describes the method of installing a necessary device driver. 

Moreover, it describes the online manipulation done from the GatewayEditor.

Chapter 11. TOOLS
This chapter describes the tool of an environmental configuration etc.

Chapter 12. CONTACTS AND REGISTERS INSIDE THE CMC15G
This chapter shows special contacts and special registers list of the CMC15G.
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Chapter 13. MAINTENANCE
This chapter describes the method of exchanging the backup batteries.

Chapter 14. SPECIFICATIONS
This chapter describes the general specifications and external dimensions of the

CMC15G.

Chapter 15. TROUBLESHOOTING
This chapter describes the cause investigation of the trouble and the treatment

method generated in using the CMC15G.
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Chapter 1 OVERVIEW
1  -  1 Overview and Features

� Overview
The CMC15G is a communication controller designed to exchange data between

another manufacturer's PLC, a host station, and a Yamatake controller or flowme-

ter connected as a slave station. By setting simple communication parameters, data

can be shared between modules, indicator values can be recorded, etc.

A specially designed PC loader tool, GatewayEditor (model No.: SLP-G15J50), is

used to set up the communication parameters and to transmit the data to the

CMC15G.

If the advanced CMC15G model is used, data can be saved from connected mod-

ules (trend, data log, and event log) to the internal memory. To transmit saved data

from the CMC15G's internal memory, a special PC loader tool, the LogViewer

(model No. SLP-G15LGV), is used.

Communication Controller CMC15G Multifunction Gateway User's
Manual "Logging Function", CP-SP-1279E (for details about
LogViewer)

Modules are connected using four serial communication channels and USB ports

(or jacks specially designed for loader use), and data can be freely exchanged

between modules without the need to write programs.
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� Features
• Easy installation and management

The CMC15G is ready for operation, after simple setting of parameters using

GatewayEditor. It is not necessary to create a communication program.

Additionally, this multifunction gateway can flexibly accommodate design

changes, and can be used to easily manage or reuse applications.

• Excellent expandability
Since the data area can be allocated freely, the registers of the PLC can be used

effectively. Additionally, since the execution timing or type of communications

can be set freely, advanced operations are possible, such as changing cycle tim-

ing according to the importance of the data or rearranging the communication

sequence.

• Wide variety of functions
Parameters and/or product type data necessary for operation are distributed to

each module in batch mode. This reduces the workload required for initial setup

and/or development of an operating program.

• Powerful design support and debug functions during operation startup
GatewayEditor supports various debug functions to solve problems caused by

incorrect wiring or improper parameter setting at the work site. GatewayEditor

can monitor the communication status of each module and the actual execution

cycle of each communication in real time.

• Powerful design support and debug functions during operation startup
(CMC15GD01 advanced model)
The logging function of the CMC15GD01 advanced model provides a wide

variety of triggers useful for analyzing and solving problems that occur at the

work site.

• Optimum for complex debugging (CMC15GD01 advanced model)
The CMC15GD01 advanced model can read out the log data from multiple

modules. The status of the slave station and the status of the host station can be

saved at the same time.

• Visual analysis (CMC15GD01 advanced model)
The LogViewer allows easy determination of the time at which events occurred.

It visually presents the state of the trend data at the time recorded in the event

log in conjunction with each logging function.

• Long-term recording (CMC15GD01 advanced model)
Using the CMC15GD01 advanced model's large-capacity internal memory and

real-time monitoring function of the LogViewer makes it possible to record data

for an extended period of time.
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1  -  2 Model Number Guide

� CMC15G

*  To use the logging function, the CMC15GD01 advanced model is required.

� Smart loader package

*  To use the logging function, the LogViewer (SLP-G15LGV) is required.

� Maintenance parts (option)

1-3
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Basic Model No. Function Module Option Specifications

CMC15G

S01 Basic model

D01 Advanced model

A Base module with connectors

000 None

Software name Model No. Note

Smart loader package SLP-G15J50 CD for Windows 2000/XP/Vista
(GatewayEditor) USB mini-B (5 pins) cable included

Smart loader package SLP-G15LGV CD for Windows 2000/XP/Vista
(LogViewer)

Part name Model No. Note

Replacement battery 81446431-001



1  -  3 Function Overview

1-4

The functions of the CMC15G can be classified into three groups: basic functions,
logging functions, and extended functions.
Basic functions include the following:
•  Data transmission •  Module setup •  Internal event
These functions are for the exchange of data between the host station and slave sta-
tion.

Logging functions include the following:
•  Continuous trend •  Captured trends
•  Data log •  Event log
These functions are for debugging the host station and slave station, and for the
saving of log data. The data collected by each function can be checked using the
LogViewer.

Extend functions include the following:
•  Status notification •  Communication error notification
•  Date and time adjustment
These functions are for notification of communication error or for confirming cor-
rect communication during data exchange.
In addition to the above functions, optional settings are also available to reduce the
load on the host station.

� Kinds of mode
The CMC15G provides the following modes. Any function can be executed when
the CMC15G is in RUN mode.
• RUN mode:  Any function operates.
• STOP mode:  All functions have stopped.
• THROUGH mode (through-communication):

Through-communication with connected modules is accomplished using the
Smart Loader Package for the controller.

� Basic functions
� Data transmission

This data transmission function shares information between modules connected to
the CMC15G. This function reads data from the slave station (such as a controller)
periodically and transmits it to the host station (such as a PLC), or it transmits data
from the host station to the slave station upon activation of a host station trigger.
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� Module setup
This function writes data (values set inside the CMC15G) to connected modules.

The initial settings for connected modules and mode change (RUN/READY) for a

slave station such as a controller can be written simultaneously upon instruction

from the host station. With GatewayEditor, it is also possible to write data in the

units used by the modules.

For each module, the setup data that has been registered in the CMC15G is written

to the module when the trigger turns ON (or OFF). This function makes it possible

to automate the setup of the controller.

� Internet event
Bits or numeric values on the connected modules are monitored in order to turn

ON/OFF a corresponding bit inside the CMC15G. This function can be utilized to

control whether communications are enabled or disabled, or as the basis for an

alarm.

Chapter 1. OVERVIEW

Controller 2

para

enter

displaymode

pv

out

sp

ot2ot1ev3ev2ev1rspman

SDC35

para

enter

displaymode

pv

out

sp

ot2ot1ev3ev2ev1rspman

SDC35

CMC15G

4

3

2

1

CH3

CH2

ALM

REC

CH

EV

RESET

USB

LOADER

RUN

4

3

2

1

POWER

CH1

17

16

15

12

RS-232C

CMC15G

11

13

14

RS-4854001 20 Input type
4002 0 Input low limit
4003 800 Input high limit
4004 0 SP low limit
4005 800 SP high limit
4006 2 EV1 type
4007 400 EV1 setting 1
4008 500 EV1 setting 2

Setup data can be created easily using 
GatewayEditor.

Module setup group 1 (Controller 1)

Module setup group 2 (Controller 2)

Module setup group 3 (PLC setup)

Write address    Data       Name

Controller

PLC
PLC register
Model code
Controller qty

Controller 1
Input type
Input low limit
Input high limit
SP low limit
SP high limit
EV1 type
EV1 setting 1
EV1 setting 2

Written by trigger

Using GatewayEditor, 
not only the PLC trigger, 
but also all sets of data 
can be sent in batch 
mode, or any individual 
set of data can be sent.

For example, when the following conditions (1) to (3) are 
all satisfied (AND), the temperature ramp-up is complete.
Condition (1): Bit M000 of the PLC is ON.
Condition (2): Current value of controller 1 is 300°C or more.
Condition (3): Current value of controller 2 is 350°C or more.

Internal bit of 
the CMC15G 
is ON.

Data 
transmission

is turned 
enable.

For example, if any of the following conditions (OR) is 
satisfied, there is a temperature error:
Condition (1): Current value of the controller 1 is 300°C or less.
Condition (2): Current value of the controller 2 is 350°C or less.
Condition (3): Alarm bit of the controller 1 is ON.
Condition (4): Alarm bit of the controller 2 is ON.

Internal bit of 
the CMC15G 
is ON.

Output 
bus is turned

ON.
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� Logging function
Handling Precautions
• To use the logging function, the CMC15GD01 advanced model and

the LogViewer (SLP-G15LGV) are required.

� Continuous trend
This function reads numeric data from connected modules at constant intervals and

records the data. Data is saved in the internal memory of the CMC15G.This func-

tion can be used to monitor, at constant intervals, changes in value.

� Captured trends function
This function reads numeric data from connected modules at constant intervals and

records the data before and after a trigger occurs. Data is saved in the internal mem-

ory of the CMC15G. Numeric data from connected modules can be recorded for a

specified period of time before and after an error occurs. This function can be used

to retain waveform information before and after an alarm occurs, in order to ana-

lyze the information for maintenance purposes. 
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� Data log
This function records data from connected modules in the internal memory of the

CMC15G whenever a change in a specified bit occurs. The status data for connect-

ed modules for one operation cycle can be saved at a specified time, such as when

the system batch process begins, or when an error occurs in a connected module.

� Event log
This function monitors a specified bit periodically. If any change occurs in the bit,

the event type and time are recorded in the internal memory.
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� Extend functional option configuration
� Extend functions

• Status notification

This function notifies the host station concerning the status of the CMC15G.

The user can verify from the host station that no error has occurred in communi-

cations between the host station and the CMC15G.

• Communication error notification

If an error occurs in communications with the connected module, this function

notifies the host station.

• Date and time adjustment

This function sets the clock of the CMC15G based on the clock data of the host

station.

� Option configuration
• Changing a node address

This allows changing of the CMC15G node address used for serial slave station

communications.

• Startup delay

The operational start of the CMC15G can be delayed until other connected

modules have started up. This can be useful for preventing a communication

error when the power is turned ON.

• Trigger device initialization

The trigger for data transmission or device setup can be initialized. This can

reduce the load on the host station.

• Initialization of completion notification device and error notification device

A device that transmits the result of communication can be initialized. This can

reduce the load on the host station.

� Digital signal input/output bus
Digital signals to/from the DMC10 can be output/input utilizing the external bus

for the DMC10. DMC10 alarms or events can be monitored, and/or a signal acting

as external switch bus input for the DMC10 can be used to change its

RUN/READY status.

Chapter 1. OVERVIEW
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� Loader through-communication
The loader for a temperature controller can be used through the CMC15G.

Handling Precautions
• To execute the loader through-communication, other communication

or data collection is stopped and the CMC15G is put in STOP mode.

• Loaders capable of loader-through communications include
Yamatake's Smart Loader Package models SLP-D10, SLP-C35, SLP-
C45, MLP100, and others.
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Chapter 2 PART NAMES AND FUNCTIONS

� Body

� Base

2-1

 Pin No. Signal
   11 SDA (CH2)
   12 SDB (CH2)
   13 RDA (CH2)
   14 RDB (CH2)
   15 SG (CH2,3)
   16 DA (CH3)
   17 DB (CH3)

POWER Orange
RUN Green
CH1 to 4 Orange
EV1 to 4 Orange
ALM Red
REC Green

4

3

2

1

CH3

CH2

ALM

REC

CH

EV

RESET

USB

LOADER

RUN

4

3

2

1

POWER

CH1

17

16

15

12

RS-232C

CMC15G

11

13

14

RS-485

POWER indicator:
Lights up green while power is
supplied. Lights up orange if
back up battery voltage has 
dropped.

RUN indicator:
Lights up green while operating, 
blinks green in loader-through 
mode. 

RESET switch:
Resets the device when 
pressed for more than 5 seconds.

CH1 to CH4 indicator:
Indicate the communications 
status of the respective channel. 
Blinks green during sending and
receiving. Lights up orange while
communications error occurs.

Loader Jack:
For dedicated cable of temperature 
controller Smart Loader Package. 
Cable connects to a PC, which is 
used for setup of this device. 

USB Connector:
For attachment of standard USB 
2.0 mini-B cable. Cable connects 
to a PC, which is used for setup of 
this device. 

EV1 to EV4 indicator:
Show the digital signal I/O bus 
state. Lights up orange while output 
is ON, lights up green while input is 
ON. EV1-EV4 lamps all blink at the 
same time if operating power 
voltage is low. The digital signal I/O 
bus is connected to the DMC by side 
connectors.

ALM indicator:
Lights up red while 
self-diagnostics found an error.

REC indicator:
Lights up green while rewriting 
a project. (On high-function 
model, lights up while recording 
a trend, and blinks while trend 
capture is enabled.) 

When power turns ON, the following 
indicators light up for one second:

Connector for CH1 communication:
   RS-232C, D-Sub 9-pin.

Connector for CH2, 3 communication:
   Both CH2 and CH3 use RS-485 
         communications.
         CH2 and CH3 share the SG
         signal. 

Mounting holes
(2 locations):
For securing the
base with M3 screws

Power supply terminal

Lever:
For securing the body

Communications
disconnection
switch:
Used for disabling
local
CPL communications
with devices linked
on the left side
(factory setting:
 CONNECT      )

DIN rail locking tab:
Used for securing on
a DIN rail

No. Signal
1 24Vdc(+)
2 24Vdc(–)
3 Do not use

Mounting hole

Side connectors
(on the both side)

No. Signal
4 DA
5 DB
6 SG

RS-485communications
terminal(CH4):
3-wire RS-485
connector terminal 

1 2

4 5

3

6
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� Communication ports for module connection
For connection of modules, such as a PLC or controller, the four communication

ports described below are available.

Communication Controller CMC15G Multifunction Gateway User's
Manual "Communication Connections", CP-SP-1278E (for details about

module connection).

� CH1:RS-232C
CH1
RD: Receive data (connected module → CMC15G)

SD: Send data (CMC15G → connected module)

ER: (Not used – internal connection with DR pin)

SG: Signal ground

DR: (Not used – internal connection with ER pin)

RS: (Not used – internal connection with CS pin)

CS: (Not used – internal connection with RS pin)

� CH2: RS-485 (5-wire), CH3: RS-485 (3-wire)
CH2
SDA: Send data (+) (CMC15G → connected module)

SDB: Send data  (–) (CMC15G → connected module)

RDA: Receive data (+) (connected module → CMC15G)

RDB: Receive data (–) (connected module → CMC15G)

SG: Signal ground

CH3
DA: Send and receive data (+) (CMC15G ↔ connected module)

DB: Send and receive data (–) (CMC15G ↔ connected module)

SG: Signal ground

� CH4: RS-485 (3-wire)
CH4
DA: Send and receive data (+) (CMC15G ↔ connected module)

DB: Send and receive data (–) (CMC15G ↔ connected module)

SG: Signal ground

� Transmission speed
The maximum transmission speed of each commu-

nication port is shown in the table on the right.

Handling Precautions
• Connect a terminating resistor (150 Ω, 

1/2 W) to CH2.

• Do not connect an external terminating resistor to CH3, since a resis-
tor similar to a terminating resistor is already built in.

• Do not connect an external terminating resistor to CH4, since a resis-
tor similar to a terminating resistor is already built in.
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Max. transmission speed

CH1 115.2kbps

CH2 115.2kbps

CH3 19.2kbps

CH4 38.4kbps



2-3

� PC communication port for
There are two ways to connect GatewayEditor to the CMC15G.

• USB mini-B connector

• Loader jack

Prior to using the USB connector, it is necessary to install the special device drivers

on the personal computer. Installation of the drivers can be done using "setup.exe"

on the included GatewayEditor Setup CD-ROM.

Handling Precautions
• Never attempt to use the USB mini-B and loader jack at the same

time. Doing so may cause a malfunction.

• Do not connect two or more CMC15G units to one personal computer
using USB connectors. Doing so may cause the communication to fail.

• Do not apply unreasonable force to the USB loader jack, or it may
break.

� Digital signal input/output bus for DMC10
A digital signal can be input or output to/from the DMC10 by utilizing the

DMC10's event bus output and external switch bus input. There are four digital sig-

nal input/outputs.

Note
• Use of the event output module (the DMC10E) enables use of event output.

Handling Precautions
• The input process delay and output delay of the digital signal may vary

depending on the internal processing load.

• When the event bus output from the DMC10 is used for the digital sig-
nal input of the CMC15G, the processing load is checked on the online
monitor and appropriate measures are taken so that the digital signal
input does not change for a period of time twice longer than the pro-
cessing cycle of the CMC15G.

• The delay time of the digital signal output from the CMC15G may vary
depending on the processing load. Allow sufficient time when checking
the process on the online monitor.

Chapter 2. PART NAMES AND FUNCTIONS
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� Display unit
� LED indicators for main unit status 

The meaning of the main unit LED indicators is as follows.

• POWER indicator
This indicator is used to check the power supply status of the CMC15G main unit.

Chapter 13, MAINTENANCE (detailed corrective actions for backup battery

voltage drop)

• ALARM indicator
This indicator shows the results of self-diagnosis by the CMC15G.

Chapter 15, TROUBLESHOOTING (self-diagnosis errors)

• RUN indicator
This indicator shows the current mode of the CMC15G.

• REC indicator
This LED indicates whether the CMC15G trend function is recording. It is also lit

while project data is being written to the CMC15G's built-in flash ROM.

Chapter 2. PART NAMES AND FUNCTIONS

ALM

RECRUN

POWER

CH1 RS-232C

POWER indicator

RUN mode

ALARM indicator

Trend recording status

Status Meaning

Off CMC15G power is OFF.

Green CMC15G power is ON.

Orange Backup battery voltage has dropped (replace the backup battery).

Status Meaning

Off Unit is operating correctly

Red An error was found during self-diagnosis.

Status Meaning

Off No CMC15G functions are running.

Flashing green The loader (SLP, etc.) for the controller is executing through-
communication with the slave station through the CMC15G.

Green CMC15G functions are running.

Status Meaning

Off Not recording.

Green • Continuous trend or captured trends are recording.
• Project data is being written.

Flashing green, • A CMC15G function is being recorded.
1 s intervals • The captured trends function is running after a trigger occurred.

Flashing green, Captured trends function is running but capture memory is full.
200 ms intervals
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� CH1 to CH4 indicators

This indicator shows the status of the communication port for connection of the rel-

evant module.

� EV1 to EV4 indicators

When the DMC10 is connected to the CMC15G, these indicators show the status

of the four digital signal inputs and outputs for the event bus outputs and external

switch inputs of the DMC10.

Power failure indication
If a power failure (supply power voltage drop) occurs, the EV1 to EV4 indicators

all flash orange. 

� Reset switch
This switch is used to reset the main unit. Press for 5 s or longer with a fine-tip

object. Resetting means that the CMC15G is restarted by means of software.

Afterwards, the status of each function is the same as it is when the power is first

turned ON.

� Communication disconnection switch

This switch is used to disable RS-485 communications with the module connected

through the CH4 connector located on the left of the communication controller

main unit. The factory setting is "CONNECT" (communication enabled).

Chapter 2. PART NAMES AND FUNCTIONS

CH

4

3

2

1CH1 status

CH2 status

CH3 status

CH4 status

Status Meaning

Off No communications.

Flashing green Communicating

Orange No response or faulty message received

4

3

2

1

CH3

EV

17

16

15

12

CMC15G

13

14EV1 input/output

EV2 input/output

EV3 input/output

EV4 input/output

Status Meaning

Off No digital signal inputs or outputs.

Green There is a digital signal input.

Orange There is a digital signal output.

Flashing orange Power failure.

CONNECT
SW
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� Backup battery
The diagram below shows the appearance of the main unit when viewed from the

mounting base. 

When the power is turned OFF, the backup battery maintains the items shown

below.

Calendar clock

Backup memory

System history

Logging function data

Chapter 13, MAINTENANCE (details on backup battery replacement)

Chapter 2. PART NAMES AND FUNCTIONS

Connector

Battery

FastenerBattery cable

PCB A

PCB B



Chapter 3 MOUNTING

� Mounting locations
Avoid installing the CMC15G in the following locations:

• Locations subject to high and low temperature, high and low humidity exceeding

the specified ranges

• Locations subject to corrosive gases such as sulfide gases

• Locations subject to dust or oil fume

• Locations subject to direct sunlight, wind or rain

• Locations subject to vibration or shock exceeding the specified ranges

• Locations under high-voltage lines and near sources of electrical noise such as

welders

• Locations within 15 meters of high-voltage ignition equipment such as boilers

• Locations where magnetic fields are generated

• Locations near flammable liquid or steam

� Linking modules
The CMC15G can be linked with other modules by the connectors on the left and

right of the base.

Modules must be linked before the CMC15G is mounted on the DIN rail or mount-

ed by screws.

By linking modules together, the power supply of each module and RS-485 (CH4)

communications are connected, eliminating the need for wiring.

RS-485 (CH4) communications can be disconnected by the communications dis-

connection switch located on the base.

� Mounting method
The CMC15G base can be mounted either by screws or by attachment to a DIN

rail.

Handling Precautions
• Install this module so that it is vertical, with the DIN rail locking tab at

the bottom.

� When mounting the base by screws
Secure the two mounting holes on the base by M3 screws.

3-1
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� When securing on a DIN rail
Secure the base on the DIN rail, fully draw out the DIN rail locking tab and hook

the base onto the DIN rail. Next, push the DIN rail locking tab upwards until you

hear it click into place.

� Mounting the body on the base
Please the hook into the base and push the body into the base until you hear it click

into place.

To remove the body from the base, pull the body towards you while pressing down

the lever.

Hook

Lever

Base

Chapter 3. MOUNTING



Chapter 4 WIRING

� Recommended cable
• Use shielded polyethylene insulated vinyl sheathed instrumentation cable for

RS-485 input/output and power supply.

• If electromagnetic induction is comparatively low, a shielded multi-core micro-

phone cord (MVVS) can be used.

• Use shielded cable for RS-232C input/output.

� Wiring precautions
Be sure to use crimped terminals for wiring terminals. When wiring is finished,

check the connections for any miswiring before turning the power ON.

� Connecting the power supply
Connect the 24Vdc power supply to terminals (1) and (2) on the base.

Handling Precautions
• Power is mutually connected between linked modules. Supply power

to one of the linked modules.

• Select a power supply that can cover the total power consumption of
all linked modules. Select a power supply that can cover the total
power consumption of all linked modules. If the total power supply is
insufficient, EV1 to EV4 indicators blink in sync.

• If the power supply capacity is insufficient, the voltage will be too low,
resulting in blinking of EV1 to EV4, or repeated resetting.

4-1

Fujikura Ltd. 2 conductors IPEV-S-0.9mm2X1P

3 conductors ITEV-S-0.9mm2X1T

Hitachi Cable, Ltd. 2 conductors KTEV-S-0.9mm2X1T

3 conductors KPEV-S-0.9mm2X1P

1 2 3

+ -
24Vdc +10%

Do not use

-
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� Connecting for CH1 communications (RS-232C)
Connect the cable to the D-Sub 9-pin connector on the CMC15G.

*1 Pins 1, 4 and 6 are connected to each other internally.

*2 Pins 7 and 8 are connected internally.

� Connecting for CH2 communications (RS-485)
This channel is for a 5-wire or 3-wire RS-485 connection. The connector for this

interface is attached. Connect the terminating resistor (150Ω, 1/2W).

Handling Precautions
• Be sure to connect SG terminals each other. Failure to do so might

cause unstable communications.

� Connecting for CH3 communications (RS-485)
This channel is for a 3-wire RS-485 connection. The connector for this interface is

attached. This is shared with CH2.

Chapter 4. WIRING

Pin No. Signal Contents

1 *1 CD Not used

2 RD Receive data
(connected module → CMC15G)

3 SD Send data
(CMC15G → connected module)

4 *1 ER Not used

5 SG Signal ground

6 *1 DR Not used

7 *2 RS Not used

8 *2 CS Not used

9 CI Not used

SG
ER
SD
RD
CD

CI
CS
RS
DR

1

5

6

9

Pin No. Signal Contents

11 SDA Send data (+)
(CMC15G → connected module)

12 SDB Send data (–)
(CMC15G → connected module)

13 RDA Receive data (+)
(connected module → CMC15G)

14 RDB Receive data (–)
(connected module → CMC15G)

15 SG Signal ground

DA             DB             SG

13 14 1511

SDA          SDB      RDA          RDB           SG

12

Terminating resistor

Pin No. Signal Contents

15 SG Signal ground

16 DA Send and received data (+)
(CMC15G ↔ connected module)

17 DB Send and received data (–)
(CMC15G ↔ connected module)

16 17 15DA            DB            SG

SDA     SDB   RDA    RDB              SG

Example: connecting to 5-wire product

Example: connecting to 3-wire product
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Handling Precautions
• Do not additionally connect a terminating resistor because an equiva-

lent resistor has been already built in for CH3. Therefore, even if other
instrument used in combination requests a terminating resistor, never
connect such resistor externally.

• Be sure to connect SG terminals each other. Failure to do so might
cause unstable communications.

� Connecting for CH4 communications (RS-485)
This channel is for a 3-wire RS-485 connection. This interface is connecting to the

terminal of base.

Handling Precautions
• Do not additionally connect a terminating resistor because an equiva-

lent resistor has been already built in for CH4. Therefore, even if the
instructions for another connected device say to install a terminating
resistor, do not do so.

• Be sure to connect SG terminals each other. Failure to do so might
cause unstable communications

� Device connections and configuration
� Number of connected units

A maximum of 31 units can be directly connected to the device communication

ports on each of CH2, CH3, and CH4.

Handling Precautions
• When used with the DMC10, a maximum of 15 units can be directly

connected, due to the limitation of the rotary switch.

� When connecting 31 or more units
To connect more than 31 Yamatake devices to each channel, the CMC10B com-

munication controller (CPL/CPL converter, sold separately) is required.

Handling Precautions
• The number of connected units refers to the number of units that can

be connected electrically. In this kind of connection, you must check
whether or not the transmission speed is suited to the required level in
the application. Consult a Yamatake sales agent.

• Event output module DMC10E is not included in the number of con-
nected units.
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Pin No. Signal Contents

4 DA Send and received data (+)
(CMC15G ↔ connected module)

5 DB Send and received data (–)
(CMC15G ↔ connected module)

6 SG Signal ground

4 5 6DA            DB            SG

SDA     SDB   RDA    RDB              SG

Example: connecting to 5-wire product
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� Setting the device address
The device address must be set to the unit in order to use the unit.

Set the device address as follows:

Handling Precautions
• The same device address number cannot be used on the same chan-

nel. For the devices connected to the same channel, be sure to use a
different device address.

Setup example 

Address of device (1) connected to CH3: 1

Address of device (2) connected to CH3: 2

Address of device (3) connected to CH4: 2

Address of device (4) connected to CH4: 3

� Connection of Yamatake devices through the CMC10B 
It is necessary also to set up a device address for each device connected through the

CMC10B. These addresses are handled as sub-addresses by the CMC15G.

Chapter 4. WIRING

Device address 1 Device address 2

Device address 2 Device address 3

CH4

CH3

There is no problem because 
the channels are different.

CMC10B
Handled as sub-address

1 2 3 4 5 6

2 3 4 5 6

1

}

}Device address 1 Device address 1 to 6

Device address 2 to 6
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Handling Precautions
• Be sure to set the device address of DMC10s connected to the same

CMC10B to unique values.

• The same device address can be used when a DMC10 is connected
to different CMC10Bs.

Communications Controller CMC10B (CPL/CPL Converter) separate

Instruction Manual, Design Manual CP-SP-1064E (for details on CMC10B

settings).

� Layout of event output module DMC10E
Only one event output module DMC10E can be used within a group linked by

connectors. When the connection is made by wiring from the bases without using

the side connectors as shown below, each group is independent and a new event

output module can be used.

Handling Precautions
• Within a single group of units connected by side connectors, there can

be only one event output module by which output can be done from
the CMC15G.

� Position of event output module

The event output module DMC10E can be positioned anywhere within a linked

group.

Chapter 4. WIRING

DMC10E

RS-485 communication
RS-485 communication

DMC10E

DMC10E

DMC10E

DMC10E

Two or more units cannot be used
in the same group.





Chapter 5 BASIC FUNCTIONS
5  -  1 Data Transmission

This data transmission function exchanges data among modules connected to the CMC15G.

Data is read from slave stations (controllers, etc.) periodically and written to the host station (PLC, etc.), or else data

from the host station is written to the slave stations upon activation of a trigger at the host station. 

Accordingly, there are two execution methods, cyclic execution and trigger execution.

� Cyclic execution
This cyclic execution function reads data from connected modules periodically and

writes the data to another specified module.

This function is used when, for example, the host station monitors the slave station

data at constant intervals.

Major applications

• Information from slave stations is shown on a display unit connected to the host

station.

• Information from slave stations is recorded at the host station.

• Information from slave stations is utilized to control the host station.

5-1
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� Description of operation
Cyclic execution begins at constant intervals. There are two startup methods, cyclic

(auto) and cyclic (fixed).

• Cyclic (auto):  The CMC15G determines an execution interval based on the

average processing time.

• Cyclic (fixed):  Cyclic execution begins at user-specified intervals.

� Process
The following describes the process when the CMC15G transmits data from the

slave station to the host station periodically.

(1) Execution occurs in cycles specified by CMC15G settings.

(2) Data is read from the source.

(3) The data is written to the destination.

� Operation if an error occurs
• If a process is not completed within the specified cycle, special contact SM901.0

(cycle overrun) inside the CMC15G turns ON. Note that the incomplete process

is not restarted.

Chapter 12, CONTACTS AND REGISTERS INSIDE THE CMC15G

• If a communication error occurs when reading data from the source, the data

containing the error is not written. Processing of other lines (subsequent data) is

executed. If error notification has been specified, notification of process comple-

tion and of the error is sent to the host station after all processes have been com-

pleted.

• If a communication error occurs when writing data, the processing of other lines

(subsequent data) is executed. If error notification has been specified, notifica-

tion of process completion and of the error is sent to the host station after all

processes have been completed.
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� Triggers
The trigger function reads data from connected modules and writes it to the speci-

fied modules when a change in the trigger device (for example, a bit) is detected.

Triggers are used to control the slave station on the basis of host station instructions

or status. The major applications are:

• Changing the operation status (RUN/READY) of a slave station by the host sta-

tion.

• Changing the settings (SP value, PID setting, etc.) of a slave station by the host

station.

A trigger operates if a change in the trigger device on a specified connected module

is detected. There are two kinds of triggers, trigger (OFF→ON) and trigger

(ON→OFF).

• Trigger (OFF→ON):  Executed when the value of a specified bit is changed

from OFF to ON.

• Trigger (ON→OFF):  Executed when the value of a specified bit is changed

from ON to OFF.

� Process
The following describes the operation when the data of the host station is transmit-

ted to a slave station if the specified trigger device on the host station is changed

from OFF to ON:

(1) The CMC15G monitors the trigger device periodically. After the trigger device

is turned ON, the trigger is executed.

(2) Data is read from the source.

(3) The data is written to the destination.

Note
• If the data type of the trigger device is a word, changes in value are judged

according to the contents of bit 0 (the least significant bit).

Additionally, the bit that is initialized by trigger device initialization is bit 0

(the LSB) only.
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� Operation if an error occurs
• If a communication error occurs when reading the trigger device, the trigger is

not activated.

• If a communication error occurs when reading the data, the write process is not

executed, but the processing of other lines (subsequent data) is executed. If error

notification has been specified, notification of process completion and of the

error is sent to the host station after all processes have been completed.

• If a communication error occurs when writing the data, the process of other lines

(subsequent data) is executed. If error notification has been specified, notifica-

tion of process completion and of the error is sent to the host station after all

processes have been completed.

Chapter 5. BASIC FUNCTIONS



5  -  2 Module Setup

This function writes fixed data (values stored in the CMC15G) to connected modules. 

It can be used, upon instructions from the host station, for tasks such as changing the mode (RUN/READY) of a

controller or other slave station or initializing the settings of a connected module.

Major applications

• Setup of initial values on connected modules.

• Changing the mode (RUN/READY) of connected modules in a single operation.

• Writing of operation parameters by product type to connected modules in batch

mode.
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� Triggers
If a change in the trigger device of a specified connected module is detected, data is

written to the specified memory location on the connected module.

There are two kinds of trigger, as described below.

Trigger (OFF→ON):  Executed when the value of a specified trigger device is

changed from OFF to ON.

Trigger (ON→OFF ):  Executed when the value of a specified trigger device is

changed from ON to OFF.

� Process
The following describes the operation to write the initial values (data) set for the

CMC15G to a connected module when the specified trigger device on the host sta-

tion is changed from OFF to ON:

(1) The CMC15G monitors the trigger device periodically. After the trigger device

is turned ON, the trigger is executed.

(2) The initial values (data) stored on the CMC15G are written to a destination.

Note
• If the data type of the trigger device is a word, changes in value are judged

according to the contents of bit 0 (the least significant bit).

Additionally, the bit that is initialized by trigger device initialization is bit 0

(the LSB) only.

� Operation if an error occurs
• If a communication error occurs when reading the trigger device, the trigger is

not activated.

• If a communication error occurs during writing, if error notification has been

specified, notification of process completion and of the occurrence of the error

are sent to the host station after all processes have been completed. If the com-

munication error occurs while further processing remains to be done, the pro-

cessing of other lines (subsequent data) is executed.
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5  -  3 Internal Event

This internal event function monitors the status of a bit or numeric value on a connected module in order to deter-

mine whether to turn ON or OFF a corresponding bit inside the CMC15G. The information output to the internal bit

can be utilized for locations shown below.

• The enabled-disabled setting for various functions

• Trigger device for various functions

� Cyclic execution
There are two kinds of startup methods, cyclic (auto) and cyclic (fixed), as

described below.

• Cyclic (auto):  The CMC15G determines an execution interval from the average

processing time.

• Cyclic (fixed):  The cyclic execution is started up at set intervals (in "s" (sec-

onds).

� Process
Multiple specified devices registered in the process are monitored periodically.

A specified internal event device (EM00*.*) is turned ON while all conditions are

satisfied (AND condition) or any condition is satisfied (OR condition) in the status

of the read-out device.

The following describes the process when the PV value of the controller is read out

periodically, this range is monitored, and the internal event device is set if the read

out value is beyond the range:

(1) The cyclic execution is started at intervals specified inside the CMC15G.

(2) The numeric value data is read out from a specified address.

(3) If any numeric value data is beyond a specified range, the internal event device

(EM000.0) is turned ON.

� Operation if an error occurs
• If a process is not completed within the specified cycle, special contact SM901.0

(cycle overrun) inside the CMC15G turns ON.

Chapter 12, CONTACTS AND REGISTERS INSIDE THE CMC15G

• If the communication error occurs in the read-out process, the internal event

device at the output destination is not changed.
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� Group
Basic functions and logging functions can be registered to function-related process-

ing groups. A group is a processing unit that contains a series of processes with

common startup conditions or processing details. The following table gives the

maximum number of groups per function and the number of records that can be

processed by one group.

For example, up to 100 data items (data to be exchanged between the PLC and con-

troller) and up to 200 groups can be registered for data transmission.

However, note that the total number of data items (number of groups by function ×
number of data records) cannot exceed 20,000. 
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Function Max. number Max. number of 

of groups data records inside group

Data transmission 200 100

Module setup 200 100

Internal event 20 20B
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Data transmission: Group 1
Startup condition: Trigger ON

Data 1  Read-out source  Write destination
Data 2  Read-out source  Write destination
     :
Data 100  Read-out source  Write destination

Max. 100 
data items

Max. 
200 groups



5  -  5 Execution Conditions and Processing for Each Function

The following shows the available startup conditions and processing for each function.

❍: Available  ×: Not available

� Execution conditions
Execution is either cyclic or by trigger.

� Cyclic execution
Cyclic execution operates continuously at specified intervals. 

There are two kinds of cyclic execution, auto and fixed.

• Cyclic (auto):  The CMC15G determines an execution interval based on the

average processing time.

• Cyclic (fixed):  Cyclic execution begins at intervals specified by the user (in "s"

(seconds)).

Note
• If a process is not completed within the specified cycle, special contact

SM901.0 (cycle overrun) inside the CMC15G turns ON. Note that the

process is not restarted.

Chapter 12, CONTACTS AND REGISTERS INSIDE THE
CMC15G

Cyclic (auto) ensures efficient communication with little waste. PV values or

alarms are read at high speed, and other values such as SP or PID are read at stan-

dard speed. Data having a low urgency level is assigned to a fixed cycle in "m"

(minutes) or "h" (hours).

Since cycles are classified by their priority, the overall communications perfor-

mance can be improved.
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Function Startup condition Enabled- Sequential Notifica-

disabled execution tion

Cycle Trigger setting process

Data transmission ❍ ❍ ❍ ❍ ❍

Module setup × ❍ ❍ ❍ ❍
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� Triggers
Triggers are activated when a change in the trigger device of a specified connected

module is detected.

Trigger (OFF→ON):  Executed when the value of a specified trigger device is

changed from OFF to ON.

Trigger (ON→OFF ):  Executed when the value of a specified trigger device is

changed from ON to OFF.

Note
• The trigger device specified by the trigger is never read while processing of

the group is in progress. If the trigger device changes during execution, it is

ignored.

The trigger device can be initialized before starting processing of the group.

� Trigger device initialization (on page 9-14).

• If the data type of the trigger device is a word, changes in value are judged

according to the contents of bit 0 (the least significant bit).

Additionally, the bit that is initialized by trigger device initialization is bit 0

(the LSB) only.

Handling Precautions
• If an error occurs in the trigger device readout process, the group is

not started up.

� Enabled-disabled setting
If, because of conditions, you do not want to execute a processing group that has

been started, you can stop the group execution by changing this setting.

Three choices are available:

• Always effective: The process is always enabled.

• Effective at bit status ON:  The process is enabled if the specified bit of a con-

nected module is ON.

• Effective at bit status OFF:  The process is enabled if the specified bit of a con-

nected module is OFF.

Note
• The initial value is "Always effective."

• When "Effective at bit status ON" or "Effective at bit status OFF" is set, the

specified bit is read immediately after startup.

• If an error occurs while reading the specified bit, the operation enters the

"waiting for startup" status as if it were disabled.

Chapter 5. BASIC FUNCTIONS
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The enabled-disabled setting can be utilized for applications described below.

By setting groups by controller, you can specify enabled or disabled status by indi-

vidual controller, so as to perform the following operations:

• Share application software used for the system.

• Take only specific controllers offline.

� Sequential execution
After processing begins, this function sequentially executes each process while

accomplishing the completion of each cohesive process class designated for

sequential processing.

This function can be used only when transmitting data or setting up a module.

It is used if the process order is already determined when the set values are written

to the slave station.

Click the line No. of a line you want to synchronize and press the right mouse but-

ton to select [Insert sync line (Y)], or input "SYNC" (1-byte uppercase characters)

in the "CH" cell (left end).

• Application example of data transmission
This sequential execution function is used when the writing order of the values is

already determined.

The figure below shows an example in which controller operation is stopped (the

controller is put in READY mode) by instructions given from the PLC, and then

the controller is returned to RUN status after the data has been transmitted.
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• Operation flow

(1) The CMC15G monitors the bit periodically. If the bit is changed to ON, the

sequential execution function is started.

(2) The READY constant is written to the RUN/READY address.

(3) The data is read from the source after step (2) has been completed.

(4) The read out data is written to the write destination.

(5) The RUN constant is written to the RUN/READY address after all processes in

steps (3) and (4) have been completed.

� Application example of module setup
In the example below, upon instructions from the PLC, the controller is stopped

temporarily (READY status), initial settings stored on the CMC15G are written,

and the controller resumes operation (RUN status).

• Operation flow

(1) The CMC15G monitors the bit periodically. If the bit is changed to ON, the

sequential execution function is started.

(2) The READY constant is written to the RUN/READY address.

(3) The initial values stored on the CMC15G are written to the write destination

after step (2) has been completed.

(4) The RUN constant is written to the RUN/READY address after step (3) has

been completed.
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� Notification process
This function notifies the host station of processing status. There are two kinds of

notification process functions, completion notification and error notification. The

notification process can be used only for data transmission or module setup.

� Completion notification
Completion notification turns on a bit of a specified connected module after the

processing in the groups for each function has been completed. The completion

notification is utilized to check that processing by the trigger has been completed.

� Error notification
Error notification turns on the bit of a specified connected module if a communica-

tion error (retry-out or error response) occurs in the process within the group of

each function. The error notification function is utilized to check that the process-

ing in the groups for each function has been executed correctly.

Note
• "Completion notification" is sent even if an error occurs while processing.

At the start of processing, the bits for completion notification and error notifi-

cation can be initialized.

� Notification device initialization (on page 9-14).

Chapter 5. BASIC FUNCTIONS
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� Notification timing
•  Execution timing during cyclic execution

When set for notification (without initialization) of completion and errors

When set for notification (with initialization) of completion and errors

Chapter 5. BASIC FUNCTIONS
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5-15

•  Execution timing when trigger is started up
Trigger (with initialization), log entry at trigger start, notification (without initialization) of comple-

tion and errors

Note:  After the trigger (without initialization) is turned ON, it must be turned OFF

by the host station.

Trigger (with initialization), log entry at trigger start, notification (with initialization) of completion

and errors
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Handling Precautions
• When using a trigger (with initialization), you must set the trigger

device once through the host station (such as a PLC). If a device that
is always running, such as an output coil, is used the trigger cannot be
initialized by the CMC15G.

• Multiple groups using the same trigger device
Initialization of the trigger device must not be enabled. If it is, groups
may not detect a change in the trigger device, depending on the trig-
ger initialization timing.

• Special contacts (SM900.0 to SM999.F) used as a trigger device
Initialization of the trigger device must not be enabled. If it is, initializa-
tion of the trigger device will be judged to have failed and the process
will not be executed, since the data writing process will be prohibited.
Even if the internal event memory (EM) has not failed, the initialization
is not actually done.
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5  -  6 Communication Error

� Occurrence of communication error
The following describes the kinds of communication errors:

� Operation if there is a communication error
If a communication error occurs, the occurrence is recorded in the communication

error section of the system history.

� Communication error history (on page 10-20).

The following describes the operation flow if a communication error occurs:

• If a communication error occurs when reading data from the trigger device, pro-

cessing of the group is not started.

• If a communication error occurs when reading data from the conditional bit for

the enabled-disabled setting, the setting is considered to be "disabled," and pro-

cessing of the group is not executed.

• If a communication error occurs when turning ON (or OFF) a notification

device, there is no notification to the connected module.
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Error type Description

Retry-out A retry-out error occurs if no response is received from connected

modules even though a period of time (time-out time × (number of retry

cycles) + 1 (first cycle)) has elapsed.

You can specify the desired time-out time and number of retry cycles for

each communication channel.

Communication frame error This error occurs if there is a transmission error (check code error, parity

error, overrun, or framing error) or logical error (illegal data) in the

response from connected modules.

Error response This error occurs if the response from connected modules is an error

code.





Chapter 6 LOGGING FUNCTION
6  -  1 Continuous Trend

This function reads out numeric data from connected modules periodically and records it to the internal memory of

the CMC15G. The continuous trend function can be used to monitor, at constant intervals, changes in values.

� Description of operation
� Startup

Data read-out from connected modules is executed at specified intervals.

� Process
The following describes how information from connected modules is saved to the

internal memory:

(1) For startup of the continuous logging function, the time is monitored at intervals

specified inside the CMC15G.

(2) Numeric data is read out from the source.

(3) The data, which is read out from the internal memory of the CMC15G, is saved

as a record with date and time recorded.

(4) If the number of saved records exceeds the maximum, the latest record is writ-

ten over the oldest record.

Handling Precautions
• The maximum number of records, which can be saved for one group

can be specified. However, the settings may need to be adjusted on
account of other groups or the entire log function, so that the usage
capacity of the internal memory does not exceed the maximum level.
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� Operation if an error occurs
• Cycle overrun

If the collection cycle is too short for the amount of data to be collected, a cycle

overrun occurs. If this occurs, treatment of the record is as described below. A

separating vertical line is displayed on the LogViewer.

• Collection device read-out communication error

If a communication error occurs while reading data due to a module fault, one

invalid record showing that data has not been collected is recorded. (This record

is displayed as "---" on the LogViewer.)

When there is successfully read data in the same group in which a communica-

tion error occurred, information showing the valid data is recorded in the invalid

record. (The total amount collected is displayed on the LogViewer.)

• Discontinuous data

If any of the following conditions arises, the record is not recorded during this

period. (A separating vertical line is displayed on the LogViewer.)

• The CMC15G is turned OFF.

• Read-out is stopped by a change in the enabled-disabled setting.

• The time is advanced by the date and time adjustment function or the online

date and time setting function.

� Display
The REC LED indicator functions as described below during continuous trend logging.

Actual time

10:10:10 1 0 0 2 0 0 3 0 0

2 0 1 3 0 1

---

---

---

2 0 3 3 0 3

2 0 4 3 0 4

2 0 5 3 0 5

2 0 6 3 0 6

1 0 1

1 0 2

1 0 4

1 0 5

1 0 6

10:10:11

10:10:12

10:10:13

10:10:14

10:10:15

10:10:16

No.1 No.2 No.3

←Data delay in Nos. 2 and 3

←Data received successfully 
    in Nos. 2 and 3 at 13 s.
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Recorded time

Contents of record

10:10:10 1 0 0 2 0 0 3 0 0

2 0 1 3 0 1

2 0 3 3 0 3

2 0 4 3 0 4

2 0 5 3 0 5

2 0 6 3 0 6

1 0 1

1 0 2

1 0 4

1 0 5

1 0 6

10:10:11

10:10:12

10:10:14

10:10:15

10:10:16

No.1 No.2 No.3

Data received successfully is 
recorded in 12 s row.

There is no record at 13 s.

Status Meaning

Off Not recording

Lit green A trend function is recording



6  -  2 Captured Trends Function

The captured trends function reads numeric data from connected modules periodically. When a trigger occurs, it

saves data from before and after the trigger to the internal memory of the CMC15G.

Waveform information from before and after the occurrence of an alarm is kept and can be used for analysis during

maintenance work.

� Description of operation
� Startup

Data is read from connected modules at specified intervals.

If a trigger is detected, the data written to the ring buffer before and after the occur-

rence is read from the buffer and saved.

There are two methods of starting the captured trends function, as described below.

• Trigger capture (OFF→ON):  Executed when the value of a specified bit

changes from OFF to ON.

• Trigger capture (ON→OFF):  Executed when the value of a specified bit

changes from ON to OFF.

� Process
The following describes the process of periodic data collection and saving of data

before and after an alarm occurs:

(1) The captured trends function is started up at intervals specified inside the

CMC15G.

(2) Data is read from the source.

(3) Data which has been read is written to the ring buffer with the date and time.

(4) If the specified bit is changed to ON (or OFF), the data before the alarm

occurred is read from the ring buffer and saved.

(5) Data after alarm occurrence is read from the ring buffer and saved.

Note
• The user can select whether or not past captured data should be overwritten if

the memory for captured data is full.

6-3
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Date & time
CMC15G

(1) Start of cycle

(4) Trigger device change is detected

D1000

D2000

D3000

CH1 PV

CH2 PV

CH3 PV

CH4 PV

ALARM

Controller (DMC10)

Data is saved if trigger device
change is detected.

(2) Data 
read out

(3) Data in the amount of the number of
records saved before an alarm occurs
is constantly being saved to the ring buffer.

(5) Data after the alarm occurred 
is read from the buffer and
saved.

Data for specified 
number of captures 
can be saved.
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Handling Precautions
• If a trigger occurs when the enabled-disabled setting is "disabled," it is

ignored.

• If a new trigger occurs when saving data after a trigger has occurred, the
new trigger is ignored.

• In addition to the memory area for captures, there is a separate memory
for the ring buffer.

• After the maximum number of captures have been saved, if the overwrite
save function is not set, the captured trends function will not operate until
recorded data is cleared.

• The settings for the number of captures and the number of saved records
should take other groups and the overall logging function into account, so
that the capacity of the internal memory is not exceeded.

Note
• If the data type of the trigger device is a word, changes in value are judged

according to the contents of bit 0 (the least significant bit).

Additionally, the bit that is initialized by trigger device initialization is bit 0

(the LSB) only.

� Display

The REC indicator functions as described below while the captured trends function

is active.

Note
• The REC LED indicator starts flashing in green (at 1 s intervals) when the

trigger of the captured trends function is activated. Note that this is not the

time at which the post-trigger data is saved.

• The REC LED indicator starts flashing green (at 200 ms intervals) when the

last trigger of the number of captures for the captured trends function is acti-

vated. Note that this is not the time at which the post-trigger data is saved

completely.
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Status Meaning

Off Not recording

Lit green Trend recording is in progress.

Flashing green The captured trends function is running after a trigger 
(1 s intervals) occurred.

Flashing green. Captured trends function is running but capture memory is 
(200 ms intervals) full.
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� Operation if an error occurs
• Trigger device read-out communication error

If a communication error occurs when reading data from the trigger device, the

trigger is not activated.

• Cycle overrun

If the collection cycle is too short for the amount of data to be collected, a cycle

overrun occurs. If this occurs, treatment of the record is as described below. A

separating vertical line is displayed on the LogViewer.

• Collection device read-out communication error

If a communication error occurs while reading data due to a module fault, one

invalid record showing that data has not been collected is recorded. (This record

is displayed as "---" on the LogViewer.)

When there is successfully read data in the same group in which a communica-

tion error occurred, information showing the valid data is recorded in the invalid

record. (The total amount collected is displayed on the LogViewer.)

• Discontinuous data

If any of the following conditions arises, the record is not recorded during this

period. (A separating vertical line is displayed on the LogViewer.)

• The CMC15G is turned OFF.

• Read-out is stopped by a change in the enabled-disabled setting.

• The time is advanced by the date and time adjustment function or the online

date and time setting function.
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Actual time

10:10:10 1 0 0 2 0 0 3 0 0

2 0 1 3 0 1

---

---

---

2 0 3 3 0 3

2 0 4 3 0 4

2 0 5 3 0 5

2 0 6 3 0 6

1 0 1

1 0 2

1 0 4

1 0 5

1 0 6

10:10:11

10:10:12

10:10:13

10:10:14

10:10:15

10:10:16

No.1 No.2 No.3

←Data delay in Nos. 2 and 3

←Data received successfully 
    in Nos. 2 and 3 at 13 s.

Recorded time

Contents of record

10:10:10 1 0 0 2 0 0 3 0 0

2 0 1 3 0 1

2 0 3 3 0 3

2 0 4 3 0 4

2 0 5 3 0 5

2 0 6 3 0 6

1 0 1

1 0 2

1 0 4

1 0 5

1 0 6

10:10:11

10:10:12

10:10:14

10:10:15

10:10:16

No.1 No.2 No.3

Data received successfully is 
recorded in 12 s row.

There is no record at 13 s.



6  -  3 Data Log
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The data log function records information from the connected modules in the internal memory of the CMC15G
when a change in the bit is detected. Status data from the connected modules for one cycle is saved if a system batch

process is started or if an error occurs in the connected modules.

� Description of operation
� Startup

If a change in the bit of a specified connected module is detected, the data read-out

from the connected module is executed.

There are two kinds of trigger startup methods, trigger (OFF→ON) and trigger

(ON→OFF), as described below.

Trigger (OFF→ON):  Executed when the value of a specified trigger device is

changed from OFF to ON.

Trigger (ON→OFF ):  Executed when the value of a specified trigger device is

changed from ON to OFF.

� Process
The following describes how the settings for the connected modules are saved if a

process (trigger occurrence) for the system arises:

(1) The CMC15G monitors the bit periodically. If the bit is turned ON, the data log

function is started.

(2) Numeric value data is read from the specified device.

(3) The data which was read is saved to the internal memory of the CMC15G as

records with date and time data.

(4) If the number of saved records exceeds the maximum, the next record is over-

written onto the oldest record.

Note
• If the data type of the trigger device is a word, changes in value are judged

according to the contents of bit 0 (the least significant bit).

Additionally, the bit that is initialized by trigger device initialization is bit 0

(the LSB) only.
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(4) If the number of saved records
exceeds the maximum, the oldest
record is cleared.

D1000

M01000

D2000

D3000

CH1 PV

CH2 PV

CH3 PV

CH4 PV

Controller (DMC10)
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Handling Precautions
• The maximum number of records that can be saved for one group can be

specified in the configuration process. However, the settings should take
other groups and the overall logging function into account, so that the
capacity of the internal memory is not exceeded.

� Operation if an error occurs
• Trigger device read-out communication error

If a communication error occurs when reading data from the trigger device, the

trigger is not activated.

• Collection device read-out communication error

If a communication error occurs while reading data due to a module fault, one

invalid record showing that data has not been collected is recorded. (This record

is displayed as "---" on the LogViewer.)

When there is successfully read data in the same group in which a communica-

tion error occurred, information showing the valid data is recorded in the invalid

record. (The total amount collected is displayed on the LogViewer.)

Chapter 6. LOGGING FUNCTION



6  -  4 Event Log
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� Description of operation
� Startup

There are two startup methods, cyclic (auto) and cyclic (fixed).

• Cyclic (auto):  The execution interval is automatically determined from the

average process time.

• Cyclic (fixed):  The event log is executed at specified intervals.

� Process
Multiple bit s registered for the process are monitored periodically.

When the state (ON/OFF) of a specified bit changes, the device's type and the time

are recorded. There are three kinds of bit ON/OFF detection (events) as described

below.

• Trigger (OFF→ON):  Executed when the value of a specified trigger device is

changed from OFF to ON.

• Trigger (ON→OFF ):  Executed when the value of a specified trigger device is

changed from ON to OFF.

• Trigger (OFF→ON/ON→OFF):  A record is added to the event log at both the

start and finish of the trigger.

When multiple bit s are monitored and a change occurs, the following describes

how the event and the date and time are saved:

Handling Precautions
• The maximum number of records that can be saved for one group can

be specified in the configuration process. However, the settings should
take other groups and the overall logging function into account, so that
the capacity of the internal memory is not exceeded.

Note
• If the data type of the trigger device is a word, changes in value are judged

according to the contents of bit 0 (the least significant bit).

Additionally, the bit that is initialized by trigger device initialization is bit 0

(the LSB) only.

PLC

Status

I D

CMC15G

D1000

D2000

D3000

CH1 PV

CH2 PV

CH3 PV

CH4 PV

Controller (DMC10)

Date & time

(1) Start of cycle

(2) Data read out

(4) If the number of saved records
exceeds the maximum, the oldest
record is cleared. 

(3) If any bit change
is detected, the
event is saved.
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� Operation if an error occurs
• Cycle overrun

If the process is not completed within the specified cycle, the process is not run

again.

• Bit read-out communication error

If a communication error occurs in the bit read-out process, the bit's value is not

judged and no judgement results are recorded.

Chapter 6. LOGGING FUNCTION



6  -  5 Groups and Execution Conditions
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The following describes the number of groups, which can be registered for each logging function, and the startup

conditions:

� Groups

� Execution conditions

❍: Available  ×: Not available

For details about startup conditions and the enabled-disabled setting, refer to 

Section 5-5, Execution Conditions and Processing for Each Function.
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Function Startup Enabled- Sequential Notifica-

condition disabled execution tion

Cycle Trigger setting process

Continuous trend ❍ × ❍ × ×
Capture trends × ❍ ❍ × ×
Data log × ❍ ❍ × ×
Event log ❍ × ❍ × ×

Function Max. groups Max. records per group 

Continuous trend, captured trends 20 30

Data log 20 100

Event log 20 100



Chapter 7 EXTENDED FUNCTIONS AND OTHER FUNCTIONS
7  -  1 Status Notification

This function sends a notification to the host station regarding the status of the CMC15G.

� Running notification
This function is used when the host station needs to confirm that the CMC15G is

operating correctly. By monitoring a notification device specified by the

CMC15G, the host station can confirm that the CMC15G is operating correctly.

The running notification function turns ON a notification device specified by the

host station at specified intervals (in "min" (minute)) while the CMC15G is run-

ning.

� Process

(1) The CMC15G starts up at set intervals.

(2) The specified notification device is turned ON.

(3) The PLC monitors the notification device at intervals twice longer than those

set for the CMC15G.

(4) When the notification device specified by the PLC is found to be ON, the bit is

turned OFF.

� Operation if an error occurs
• If a process is not completed within the specified cycle, special contact SM901.0

(cycle overrun) inside the CMC15G turns ON.

Chapter 12, CONTACTS AND REGISTERS INSIDE THE CMC15G
• If a communication error occurs when the notification device is turned ON (or

OFF), no notification is sent to the connected module.
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(3) Confirmation

(4) Contact reset
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� Battery alarm notification
This function notifies the host station regarding the battery status of the CMC15G.

Battery alarm: Voltage level of the CMC15G's backup battery is below a speci-

fied level.

By monitoring the specified notification device, the status of the CMC15G can be

checked. When alarm status occurs, the bit is turned ON at the intervals specified

by the user (in "min" (minute)).

� Process
The following describes how periodic notification of the battery alarm is sent to the

host station.

(1) The battery alarm notification function is started up at set intervals.

(2) Battery alarm occurrence is checked.

(3) If there is a battery alarm, the specified bit on the host station is turned ON.

� Operation if an error occurs
• If a process is not completed within the specified cycle, special contact SM901.0

(cycle overrun) inside the CMC15G turns ON.

Chapter 12, CONTACTS AND REGISTERS INSIDE THE CMC15G
• If a communication error occurs when the notification device is turned ON (or

OFF), no notification is sent to the connected module.
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(1) Start of cycle

(3) Contact ON

(2) Battery alarm confirmation.
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� Capture notification/Capture limit notification
Only the CMC15GD01 advanced model can use these functions.

Capture notification: At least one data record has been collected by the cap-

tured trends function.

Capture limit notification: The captured trends function cannot accept another trig-

ger.

Handling Precautions
The capture and capture limit statuses are retained until the data is down-
loaded or the recorded data is cleared.

By monitoring the specified notification device, the status of the CMC15G can be

checked. When alarm status occurs, the bit is turned ON at the intervals specified

by the user (in "min" (minute)).

� Startup
The capture notification and capture limit notification function are started up at

specified intervals (in "min" (minute)).

� Process
A specified bit is turned ON at the intervals specified (in "min" (minute)) when the

relevant status occurs. The following describes the process for sending periodic

capture limit notification to the host station.

(1) The time is monitored at specified intervals for startup of the capture notifica-

tion and capture limit notification functions.

(2) The capture status is checked.

(3) If the memory for capture is full, the specified bit on the host station is turned

ON.

� Operation if an error occurs
• If a process is not completed within the specified cycle, special contact SM901.0

(cycle overrun) inside the CMC15G turns ON.

Chapter 12, CONTACTS AND REGISTERS INSIDE THE CMC15G

Additionally, note that the process is not started again.

• If a communication error occurs when the notification device is turned ON (or

OFF), no notification is sent to the connected module.
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(3) Contact ON

(2) Battery alarm confirmation.



7  -  2 Communication Error Notification
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The communication error notification function sends notice of an error to the host station if an error occurs in com-

munication between the CMC15G and a connected module. By monitoring a specified bit, the host station can

check if there has been an error in communication with a connected module.

A communication error occurs if the retry-out or error response occurs during communication. If a communication

error is detected, a bit corresponding to the module in which the error occurred is turned ON.

Notification of a communication error is sent to the host station in the following way:

(1) The CMC15G detects the error.

(2) The specified bit on the host station is turned ON.

� Operation if an error occurs
If a communication error occurs when the notification device is turned ON (or

OFF), connected modules are not notified.

Handling Precautions
• Even after resumption of normal operation, the specified bit on the host

station is not turned OFF.

• Notification occurs only once, even if normal operation is not restored
after an error such as faulty wiring.

• If normal operation and error status restoration occur repeatedly, the
shortest interval at which the specified bit on the host station is turned
ON is 1 s.
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7  -  3 Date and Time Adjustment

This date and time adjustment function adjusts the year, month, day, hour, minute, and second data on the CMC15G
to the date and time of the system. The settable date and time range is from 00:00:00 on January 1, 2000 to 23:59:59
on December 31, 2099. You need to separately specify a memory address on a connected module for each of year,
month, day, hour, minute, and second.

If a host station such as a PLC controls the date and time for the overall system, the
date and time of the CMC15G can be adjusted to the date and time of the host sta-
tion at a time specified by the host station (for example, the bit used as the trigger
device can be turned ON once a day).

When a change in the specified bit on the host station is detected, the clock data is
read out from the host station and this data is set for the CMC15G.

There are two kinds of trigger startup methods, trigger (OFF→ON) and trigger
(ON→OFF), as described below.

• Trigger (OFF→ON): Executed when the value of a specified bit is changed from
OFF to ON.

• Trigger (ON→OFF): Executed when the value of a specified bit is changed from
ON to OFF.

(1) The CMC15G monitors the bit periodically. If the bit changes to "ON," the date
and time adjustment function is activated.

(2) The year, month, day, hour, minute, and second are read from the specified
addresses, and the CMC15G's time data is set accordingly.

Handling Precautions
• Date and time adjustment cannot operate while another trigger is

being processed. If the trigger for the date and time adjustment is
detected while another trigger is being processed, reading of the date
and time data may be delayed.

• The CMC15G does not reset the trigger device. The trigger device is
turned off by the host station when a certain period of time has
elapsed after the bit was turned on.

Note
• After date and time have been adjusted, record of the change of the CMC15G

internal clock remains in the system history. The system history can be
checked with the history display function of GatewayEditor.

• If the data type of the trigger device is a word, changes in value are judged
according to the contents of bit 0 (the least significant bit).

Additionally, the bit that is initialized by trigger device initialization is bit 0
(the LSB) only.

� Operation if an error occurs
• If a communication error occurs when reading the trigger device, the date and

time data is not adjusted. 7-5
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7  -  4 Option Configuration

This option configuration function sets up optional functions of the CMC15G main unit. Optional functions like

CMC15G startup or initialization of variables (bits) related to functions can be set.

� Node address
The node address for the CMC15G can be changed. A node address is specified

when the CMC15G is configured as a slave station. It is used for communication

with the host computer.

� Startup delay
This function delays the operation of the CMC15G after power-up until the set

time.

The delay time can be set in seconds (s). If the startup of a connected module is

later than that of the CMC15G, a communication error may occur.

By setting the startup delay, operation of the CMC15G can be postponed until all

connected modules have been started. The setting range is 1 to 360 s.

Handling Precautions
• Even when the startup delay has been set, the RUN indicator will light

up immediately after the power has been turned ON.

� Trigger device initialization
In trigger processing, normally the host station initializes the trigger device.

However, if this is not desired, the CMC15G, when it starts up, can initialize trig-

ger devices that have been changed to execution status.

Functions that can be initialized are the basic data transmission and module setup

functions. You can select "Initialize" or "Do not initialize" for each function. The

initial value is "Initialize":

For trigger (ON→OFF), the bit is turned ON.

For trigger (OFF→ON), the bit is turned OFF.

A trigger device initialization function for date and time adjustment has been added

in F/W versions 0002.01.01 and later. 

If a version earlier than Ver. 0002.01.01 is used, or if GatewayEditor Ver. 1.x.x is

used, the trigger device initialization function is disabled.

• If a project that was created using a previous version of GatewayEditor is

opened with GatewayEditor Ver. 2.x.x or later, the trigger device initialization

function for date and time adjustment is disabled.

• If a project that was created using the new GatewayEditor is used with previous

firmware, downloading begins in the same way as when the trigger device func-

tion for date and time adjustment is set to disabled.

If the trigger device function for date and time adjustment is enabled, a message

appears at the time of downloading. If this happens, downloading will begin after

the setting has been changed to disable the function.
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Handling Precautions
• Trigger device initialization should not be enabled when the same trig-

ger device is used for multiple groups. If it is, groups may not detect
the ON trigger device, depending on the trigger device initialization
timing.

• Initialization of the trigger device must not be enabled when special
contact (SM900.0 to SM999.F) is used as a trigger device. If it is, ini-
tialization of the trigger device will be judged to have failed and the
process will not be executed, since the data writing process will be
prohibited. Even if the internal event EM has not failed, initialization is
not actually done.

• The trigger device cannot be initialized if the group's enabled-disabled
setting results in a disabled state.

The following describes how to transmit data with a trigger (OFF→ON) and how

to initialize the trigger device.

(1) The CMC15G monitors the trigger device periodically. After the trigger device

is turned ON, the trigger is executed.

(2) The trigger device is initialized (in this case, the bit is turned off).

(3) Data is read from the source.

(4) The data is written to the destination.

Note
To emulate the operation of the CMC10G, set to "Initialize."
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� Initialization of completion notification device and error notification device 
This function initializes the completion notification device or error notification

device specified by the CMC15G when a process of some function starts up.

Normally, the host station initializes the notification device. However, if this is not

desired, the CMC15G can initialize it.

The functions that you can initialize are the basic functions of data transmission

and module setup. For each, either "Initialize" or "Do not initialize" can be select-

ed. The default value is "Initialize."

Since the completion notification device or error notification device is reset after

the process has been started up, completion or error notification of the currently

running process can be detected.

The following describes how to transmit data with a trigger (OFF→ON) and how

to initialize the trigger device.

(1) The CMC15G monitors the trigger device periodically. After the trigger device

is turned ON, the trigger is executed.

(2) The completion notification device is reset.

(3) Data is read from the source.

(4) The data is written to the destination.

(5) After all write processes have been completed, the completion notification

device is turned on.
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7  -  5 Digital Signal Input/Output Bus

A digital signal can be input or output to/from the DMC10 by utilizing the DMC10's event bus output and external

switch bus input. In this way tasks can be accomplished such as monitoring DMC10 alarms using the event bus out-

put or change-over of RUN/READY or other operations with the external switch bus input. There are four digital

signal input/outputs.

When utilizing the event bus output of the DMC10 as digital signal input of the CMC15G in a function setup,

"BM0000*" (where "*" stands for a numeral from 0 to 3) is input to a memory address location.

When the digital signal output of the CMC15G is used as external switch bus input of the DMC10, "BM0000*"

(where "*" stands for a numeral from 0 to 3) is input to a memory address location.

In the above figure, the operation flow is as follows. (This example shows an oper-

ation that utilizes data transmission.)

(1) The CMC15G monitors the trigger device periodically. After the trigger device

is turned ON, the trigger is executed.

(2) Constant value "1" is written as part of "BM00001."

(3) The RSW BUS1 is turned ON.

Handling Precautions
• The input process delay and output delay of the digital signal may vary

depending on the internal processing load.

• When the event bus output from the DMC10 is used for the digital sig-
nal input of the CMC15G, the processing load is checked on the online
monitor and appropriate measures are taken so that the digital signal
input does not change for a period of time twice longer than the pro-
cessing cycle of the CMC15G.

• The delay time of the digital signal output from the CMC15G may vary
depending on the processing load. Allow sufficient time when checking
the process on the online monitor.
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7  -  6 Loader Through-Communication

When ThroughComm is used as a tool for changing the CMC15G to THROUGH mode, the dedicated loader for

any Yamatake controller can be operated through the CMC15G. The dedicated loaders which can be connected

include:

• SLP-C45
• SLP-C35
• SLP-D10
• MLP100, etc.

Handling Precautions
• Before executing loader through-communication, the CMC15G is

changed to through-communication mode (THROUGH mode). In
through-communication mode, all communications handled by the
CMC15G are stopped and only the loader through-communication is
executed.
Since loader through-communication may adversely affect the opera-
tion of the user system, you must use it carefully, taking into consider-
ation the effects on the overall system.

• Each dedicated loader is connected using the communication configu-
ration that has been set for it in the module constitution. Before start-
ing the loader through-communication, it is necessary to correctly con-
figure communication parameters such as transmission speed in the
CMC15G module constitution.

� Setup of loader through-communication
As an example, the following shows how to connect to the SDC45 at node address

2 using the SLP-C45:

Example of module constitution
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PLC

PC

SLP-C45

CMC15G DMC10 DMC10 DMC10

USB
COM port 4

SDC45
Node address 1

SDC45
Node address 2

SDC45
Node address 3

CH1  RS-232C

CH4  
RS-485

CH3  RS-485   38400bps

4

3

2

1

CH3

CH2

ALM

REC

CH

EV

RESET

USB

LOADER

RUN

4

3

2

1

POWER

CH1

17

16

15

12

RS-232C

CMC15G

11

13

14

RS-485
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Procedures
(1) Select [ThroughComm] to run it.

>> The following window will appear:

(2) Select the communication port (COM port) No. of the personal computer con-

nected to the CMC15G in the [Comm Configuration] box. In this example,

"COM port 4" is set.

(3) Select the communication channel number to which the module is connected in

the [CMC15G target CH] box. In this example, "CH4" is set.

(4) Click the [Start] button.

>> The confirmation window saying "CMC15G starts the THROUGH commu-

nication. Continue?" will appear.

(5) Click the [OK] button.
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>> The CMC15G changes to through-communication mode.

(6) The high-speed flashing of the RUN indicator on the front panel indicates that

the mode has been changed successfully.

(7) Start up the dedicated loader for each connected module. In this example, the

SLP-C45 is started.

(8) After starting the SLP-C45, select [Option] from [Menu].

>> The following window will appear:
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(9) Select the communication port (COM port) of the personal computer connected

to the CMC15G in the "Communication Port" area.

In this example, COM port 1 is selected.

(10)  Check on [Use CMC10L] in the "Communication Setup" area.

(11)  Set the station address in the "Station address/Station sub address" area.

This is the station address of the controller you wish to connect to, in this

example "2."

(12)  Set the transmission speed, data length, parity, and stop bits suitable for the

controller that will be connected.

In this example, the transmission speed is 38400 bps.

Set the data length, parity, and stop bits to the same settings as those of CH3

of the CMC15G.

After the above steps have been completed, the SLP-C45 can be connected to the

controller.

� Quitting loader through-communication
(1) Finish the work requiring the special loader, and complete online operations

such as numeric value monitoring or trend monitoring.

(2) Click the [Stop] button in the ThroughComm window.

If the ThroughComm window is not started up, start it up from the [Start] menu.

>> The following window will appear:

(3) To start it up, click [Yes]; otherwise click [No].

(4) Check the RUN indicator on the front panel to verify that the mode has been

changed.

• RUN mode: Green light.

• STOP mode: Off.

(5) Click the [Close] button to exit ThroughComm.
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Handling Precautions
• Before changing to RUN mode, make sure that system operation will

not cause problems. Sudden start of operation may greatly affect the
overall system.

• The mode display in the upper portion of the ThroughComm window
shows the result of the most recent mode change. 

If you have quit ThroughComm once, the mode of the ThroughComm
may not match the mode of the CMC15G main unit. Check the mode
status of the CMC15G with the RUN indicator on the front panel.

• If you quit ThroughComm in the loader through-communication execu-
tion status, all communications handled by the CMC15G will remain
off. Follow the steps below to resume operation.

• Click the [Stop] button in the ThroughComm window to change the
mode to RUN mode.

• Keep the RESET switch on the CMC15G pressed for at least 5 s.

• Turn OFF the power, and then turn it ON again.

• While the CMC15G is running in through-communication mode, do not
connect to it using GatewayEditor.
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8  -  1 Overview of GatewayEditor

� Functions
GatewayEditor provides the major functions described below.

• Configuration of functions (data transmission, module setup, internal events,

etc.)

• Downloading and uploading of settings

• Functional check of CMC15G main unit (online monitoring and online opera-

tion)

� System requirements

*1. Windows Me, Windows 98, Windows 95, Windows XP 64-bit Edition,

Windows Vista 64-bit Edition and Windows Server (Windows 2000 Server,

Windows Server 2003,Windows Home Server,Windows Server 2008, etc.)

are not supported.

*2. If GatewayEditor is started up in a language environment other than Japanese,

the menus are displayed in English.

*3. To communicate with the CMC15G, the personal computer must have either

a USB port or COM port interface.

8-1

O.S. Windows *1

Language *2 Japanese, English

CPU Pentium compatible CPU, 400 MHz or faster

Memory Free RAM capacity, 256 MB or more

Hard disk drive Free capacity, 128 MB or more

Display Resolution of Super VGA (800 × 600) or more

CD-ROM drive Required only when installing GatewayEditor.

Keyboard Required.

Mouse Required.

USB port *3 Required when connecting to the main unit with the
USB cable.cable.

COM port *3 Required when connecting to the main unit with the
loader cable.cable.



8  -  2 Installing GatewayEditor
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� Installing the SLP-G15

Handling Precautions
• Do not connect the CMC15G and personal computer with the USB

cable during installation. If they are connected, the USB drivers will not
be installed correctly.

(1) Insert GatewayEditor Setup CD-ROM into the CD-ROM drive. Double-click

[My Computer] to open it.

(2) Move the mouse cursor onto the icon for the CD-ROM drive, press the right

mouse button, and select [Open] from the pop-up menu.

>> The contents of the CD-ROM are shown.

(3) Double-click Setup.exe.
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>> The setup wizard screen will appear. The License Agreement screen will appear

during installation. Check the contents of the license agreement. If you agree

with the contents of the license agreement, click the [Yes] button. If you do not

agree, click the [No] button and installation will be cancelled.

>>Subsequently, a screen prompting you to input a serial number will appear.

(4) Input a user name, company name, and serial number. The serial number is

printed on the label attached to the CD-ROM case. If the serial number is not

input accurately, the installation process will not continue.

(5) If you checked [Custom] in the “Setup Type” area, 

check [GatewayEditor] and [USB Driver] on the Select Features screen.
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Components which you do not install now can be installed later by choosing the

[Modify] option in the installation wizard .

(6) If the USB drivers are installed, the following two screens may appear:

If this happens, click the [Continue Anyway] button.

(7) Follow the instructions that appear on the screen to continue the setup.

Handling Precautions
Warning messages during driver installation. This warning message will
appear if the drivers do not pass Microsoft's WHQL (Windows
Hardware Quality Labs) test for conformity to Windows standards.
However, Yamatake has conducted a complete functional check of
these drivers. Therefore, continue the installation, since no problems
will occur in the system if these drivers are installed.

Note
After GatewayEditor installation, files with the extension .gwp are registered

as GatewayEditor project files. If you double-click a gwp file, GatewayEditor

will start up and open the file as a project file.
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� Uninstalling the SLP-G15
(1) From the [Start] menu, select [Control Panel].

>> The Control Panel window will appear.

(2) In Windows 2000, Windows XP, and Windows Vista, double-click

[Add/Remove Programs], [Add or Remove Programs], and [Programs
and Features], respectively.

>> A list of installed programs is displayed.

(3) Select [SLP-G15]. In Windows 2000, Windows XP, and Windows Vista, dou-

ble-click [Change/Remove], [Change/Remove], and [Uninstall/Change],
respectively.

>> GatewayEditor and USB driver are then removed.
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Note
Project files created by the user, address selection palette favorites, etc. are not

removed.

� Upgrade-installing and maintenance-installing the SLP-G15
If the SLP-G15 setup.exe file is run after the SLP-G15 has already been installed

on the personal computer, instead of a general new installation, one of the follow-

ing two processes is started:

� Upgrade installation
If the setup.exe program is a newer version of the SLP-G15, the currently installed

version will be removed, and the new version will be installed. 

No data is overwritten onto project files created by the user, address selection

palette favorites, etc.

� Maintenance installation
If the setup.exe program is the same version of the SLP-G15, it operates in mainte-

nance installation mode.

Modify

Select functions, and selectively install or remove GatewayEditor components and

USB drivers.

Repair

If any program files have been removed accidentally, this function restores the sys-

tem configuration to that of a new installation.

Remove

Executable files (GatewayEditor and USB drivers) of the SLP-G15 are removed.

Note
Project files created by the user, address selection palette favorites, etc. are not

removed.
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Handling Precautions
• If the installation destination folder or the program folder location for

the Start menu, to which program icons are registered, is changed dur-
ing an upgrade, blank folders may remain. In this case, remove the
blank folders manually.

• If an installer program with a different version is run, the installation
information from the old version may remain in the [Add/Remove
Applications] (Add or Remove Programs) list. If Remove Programs is
executed for this old information, no program will be removed, but the
information will be deleted.

• After the “YAMATAKE (slabbus) USB” driver has been removed from
[Add/Remove Applications] (Add or Remove Programs), even though
the USB drivers are added using the [Modify] installation, the USB dri-
ver may not be installed. In this case, run the [Repair] installation.
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� Starting up GatewayEditor

To start up GatewayEditor, follow the steps below.

Click the Windows [Start] button in the lower left of the screen.

Select [All Programs] → [SLP] → [SLP-G15] → [GatewayEditor].

>> GatewayEditor then starts up and the Menu window appears.

Handling Precautions
Up to two instances of GatewayEditor can be run at the same time. If
you attempt to start a third instance, an error message will appear.

� Exiting GatewayEditor
To exit GatewayEditor, follow the steps below.

Click the [X] (close) button on the title bar. To exit GatewayEditor from the menu,

select [Exit] from the [File] menu.

>> GatewayEditor will close.

Note
You can copy or paste data between two instances of GatewayEditor while

they are both running (“double-running”).
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Create new project

Module constitution

Open project

Open file.
Upload from CMC15G.

System configuration

Module constitution
Option configuratio

Auxiliary function

Address input support
Configuration error list
Project information

Configuration by function

Data transmit
Module setup
Internal event
Extended function

Download to CMC15G Save project
Create document

Output CSV file

Online monitor

Group process status
Communication status 
of connected modules

Status display

CMC15G information
Communication error history
Operation history

Online operation

Operation mode change
Module setup
Date and time adjustment

Open

Edit

Output

Functional check and operation
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8  -  5 Configuration Functions

8-5-1 Main window

� Screen structure

� Menu
Operational items are displayed on the menu.

� Toolbar
Buttons related to menu items are displayed.

� Project view
Function configuration items for the CMC15G are displayed in a tree view format.

� Function configuration tab sheet
A configuration sheet for each function is displayed as a tab sheet in list format.

� Module selection palette, Address selection palette

When a connected module is selected on the module selection palette, a list of

addresses which can be input is displayed on the address selection palette.

To specify an address easily, drag it from the address selection palette and drop it

into the device input box on the configuration sheet.

� Configuration error list

If any configuration is incorrect, the contents of relevant error are displayed.

Address 
selection 
palette

Module 
selection 
palette

Configuration 
error list

Toolbar
Menu

Function 
configuration 
tab sheet

Project view
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� Menu bar/Toolbar
GatewayEditor functions are displayed on the menu bar and toolbar.

The following describes the conventions for each item name:

*1. Shortcut keys directly execute a menu item. They consist of [Ctrl] (or [Shift]) +
a specified key. For example, pressing [c] when [Ctrl] is pressed executes the

copy command.

Chapter 8. GATEWAYEDITOR

Icon Icons indicate relevant functions in an easily understood way.

Clicking an icon on the toolbar will execute the corresponding
function.

Item name An item name shown on the menu.

[Ctrl]+[X] Displays a shortcut key *1.

If a shortcut key is not available, no keys are displayed.
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� Menu descriptions
� File menu

Chapter 8. GATEWAYEDITOR

Menu Icon Sub-menu Description Shortcut

File Create new project Creates a new project. [Ctrl] + [N]

Open project Opens a saved project file (*.gwp). [Ctrl] + [O]

Re-open project Displays up to 10 names of the most 
recently opened files, along with their path 
(full directory location). Selecting a desired 
project file will open it.

Save project Saves the currently opened project file. [Ctrl] + [S]

Save project as Saves the currently opened project with a 
user-specified file name.

Close project Closes the currently opened project.

Export CSV file Outputs the settings of the currently opened 
project to a file in CSV format.

Project information Displays the Project Information screen, 
allowing you to check key information for the 
currently opened project (internal memory 
usage status of the CMC, etc.).

Exit Exits GatewayEditor.
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� Edit menu

Chapter 8. GATEWAYEDITOR

Menu Icon Sub-menu Description Shortcut

Edit Undo Undoes your last action. [Ctrl] + [Z]

Redo Redoes the last action that was undone. [Ctrl] + [Y]

Cut Deletes the selected character string or [Ctrl] + [X]
item and moves it to the Clipboard.

Copy Copies the selected character string or [Ctrl] + [C]
item to the Clipboard.

Paste Pastes data from the Clipboard to the [Ctrl] + [V]
selected position.

Clear Clears the selected character string or 
item.

Select all Selects all character strings or items. [Ctrl] + [A]

Delete Deletes the selected item.

Insert line Inserts a blank line at the selected [Ctrl] + [Ins]
position. The lines following the selected 
position are shifted down.

Delete line Deletes the selected line. Lines below [Ctrl] + [Del]
the deleted line are shifted up to fill in 
the space left by the deleted line.

Insert sync line Inserts SYNC showing the synchronous 
line at the selected position.

The lines next to the selected position 
are shifted down.

Move up Moves the selected item one line up. [Ctrl] + [↑]

Move down Moves the selected item one line down. [Ctrl] + [↓]

Search Displays a palette allowing you to find a [Ctrl] + [F]
specified character string.

Replace Displays a palette allowing you to replace [Ctrl] + [H]
the character string with a specified one.
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� Configuration menu

Chapter 8. GATEWAYEDITOR

Menu Icon Sub-menu Description Shortcut

Config System Construction Opens a system configuration window 
Config Option for the currently displayed project.

Extended Status Notification Opens an extended functions configura-
Function Comm Error tion sheet for the currently opened project

Notification

Date Time 
Adjustment

Create Data Transmit
new Module Setup
sheet

Trend

Data Log

Event Log

Internal event

Open Opens the item selected in the project 
view as function configuration sheet or 
configuration window.

Close Closes the configuration sheet on top of [Ctrl]+[W]
the configuration sheets that are open 
on the function configuration tab sheet.

Close all Closes all configuration sheets open on 
the function configuration tab sheet.

Show Closes the top configuration sheet open [Ctrl]+[ [ ]
prev on the function configuration tab sheet 
sheet and displays the contents of the previous 

configuration sheet.
If the previous sheet is already open, the 
opened tab becomes active.

Show Closes the top configuration sheet open [Ctrl]+[ ] ]
next on the function configuration tab sheet to 
sheet display the contents of the next configur-

ation sheet.
If the next sheet is already open, the 
opened tab becomes active.

Change Displays the “Change Group Name” 
name window, allowing you to change the 

group name of the configuration sheet 
selected in the project view.

Adds a new configuration sheet for the
currently opened project.

Trend, Data Log, and Event Log sub-
menus are displayed only when using
the CMC15GD01 advanced model.
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� Address list menu

� Communication menu

� Tool menu

� Help menu
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Menu Icon Sub-menu Description Shortcut

Address list Add to favorite Adds the item selected on the address 
selection palette to the favorites palette.

Delete from favorite Deletes the item selected on the address 
selection palette from the favorites palette.

Edit favorite list Displays a window allowing you to edit 
the favorites list by model type selected 
on the module selection palette.

Menu Icon Sub-menu Description Shortcut

Online Download PC → CMC15G Transmits the project to the CMC15G 
main unit.

Upload to CMC15G → PC Transmits the project running on the 
CMC15G main unit to the personal 
computer.

CMC15G information Reads out information (version or history) 
from the CMC15G main unit.

Online monitor Displays the Online monitor screen, 
allowing you to check the process status 
of the CMC15G function or the status of 
communication with the connected 
modules.

Online Mode change Executes an operation (operation 
operation Online Setup Module start/stop, etc.) on the CMC15G.

Online Adjust Date Time

Menu Icon Sub-menu Description Shortcut

Tool Environment Configures the GatewayEditor environ-
ment (communication with the PC, etc.).

Change Target Model Changes the target model of the project 
currently being edited.

Update System on CMC15G Updates the system of the connected 
CMC15G.

Menu Icon Sub-menu Description Shortcut

Help Help Configuration Manual Displays the user's manual (PDF file).

Communication Manual

Version Displays version information for the 
GatewayEditor.
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8-5-2 Project view
Settings for CMC15G functions are displayed in a tree view format.

You can configure each function from the project view.

The CMC15GD01 advanced model displays the logging function items in addition to the items for the standard

model.

� Screen structure

Standard model (CMC15GS01) Advanced model (CMC15GD01)

� Structure list
Project

Uppermost item in the project.

Up to 32 characters of the project file name are displayed.

If the project has not been saved to a file, “New project” is displayed.

System setting
Displays the system configuration items for the CMC15G.

•  Constitution :  Configures the modules to be connected to the CMC15G.

•  Option :  Configures CMC15G options.

Data transmit

Displays the configurable items for data transmission. Up to 200 configuration

sheets are available for each group that is a process unit.

Icons and configuration sheet names are displayed in the project view.

The user can select a configuration sheet icon by function from the following icons:

Normal

Read

Write

Read/Write
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Handling Precautions
Icons identify the process contents of each configuration. They cannot
specify the operation of the CMC15G.

Module setup
Displays the configurable items for module setup. Up to 200 configuration sheets

are available for each group that is a process unit. 

The icon and configuration sheet name are displayed in the project view.

The icon is “ Write”

Trend
Displays the configurable trend items for the CMC15GD01 advanced model.  

Displays the configurable items for module setup. Up to 20 configuration sheets are

available for each group that is a process unit. 

The icon and configuration sheet name are displayed in the project view.

The icon is “ Read”

Data Log
Displays the configurable data log items for the CMC15GD01 advanced model.  

Displays the configurable items for module setup. Up to 20 configuration sheets are

available for each group that is a process unit. 

The icon and configuration sheet name are displayed in the project view.

The icon is “ Read”

Event Log

Displays the configurable event log items for the CMC15GD01 advanced model.  

Displays the configurable items for module setup. Up to 20 configuration sheets are

available for each group that is a process unit. 

The icon and configuration sheet name are displayed in the project view.

The icon is “ Read”

Internal event
Displays the configurable items for internal events. Displays the configurable items

for module setup. Up to 20 configuration sheets are available for each group that is

a process unit. 

The icon and configuration sheet name are displayed in the project view.

The icon is “ Read”

Extended Function
Displays the configurable items for extended functions. The following are avail-

able:

• Status Notifucation: Settings for notifying the host station of the status

of the CMC15G.

• Comm Error Notification: Settings for notifying the host station of a com-

munication error between the CMC15G and a

connected module.

• Data Time Adjustment: Settings for synchronization of CMC15G date

and time with the date and time of the host sta-

tion.
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� Creating a configuration sheet
There are two ways to create a configuration sheet:

� Creating from a pop-up menu
To create a configuration sheet using a pop-up menu (right-click a function name)

in the tree view, follow the steps below.

• Procedures

(1) In the project view, select the function for which you want to create a configura-

tion sheet.

(2) Select [Create new sheet] from the pop-up menu.

� Creating from the main menu

To create a new configuration sheet from the main menu, follow the steps below.

• Procedures

(1) Select [Create new sheet] from [Config] on the main menu.

(2) Select the function item corresponding to the new sheet you want to create.
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� Opening a configuration sheet
Two ways to display multiple configuration sheets are described below.

� Opening a configuration sheet using the individual function configuration tab sheet

Multiple tab sheet displays can be changed quickly to display a desired sheet.

To open a configuration sheet using the individual function configuration tab sheet,

follow the steps below.

• Procedures

(1) Select the configuration sheet you want to open in the project view.

(2) Select [Open] from the pop-up menu or double-click the selected configuration

sheet.

Up to 100 sheets can be opened on the function configuration tab sheet at the same

time.

� Opening a configuration sheet using one function configuration tab sheet
When editing multiple sheets, it is not necessary to open or close the function con-

figuration tab sheet many times.

To change the configuration sheet and open it using one function configuration tab

sheet, follow the steps below.

• Procedures

(1) Select the configuration sheet you want to open first in the project view.

(2) Select [Config] → [Show next sheet] or [Config] → [Show prev sheet].

>> Open the next (or previous) configuration sheet on the function configuration

tab sheet currently being opened. If the next sheet (or previous sheet) is already

opened, the tab moves to the open tab. You cannot open across functions, such

as data transmission or module setup. If the last (or top) sheet is open, the next

(or previous) sheet cannot be opened.

� Editing a sheet
To edit a configuration sheet (cut, copy, paste, or delete, etc.), select a function

from the pop-up menu or main menu in the same manner as described for creation

of a new sheet.

� Selecting multiple sheets

You can select multiple configuration sheets to move or copy multiple sheets at

once.

• Area selection
• Operation with the mouse

(1) Select the configuration sheet on top (i.e., the last one) in the project view area.

(2) With the [Shift] key pressed, click the last configuration sheet (the one on top)

in the area.

• Operation from the keyboard

(1) Select the configuration sheet on top (i.e., the last one) in the project view area.
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(2) With the [Shift] key pressed, press [↑] or [↓] to specify the top (or last) in the

area.

• “Random” selection
• Operation with the mouse

(1) Select a configuration sheet in the project view.

(2) With the [Ctrl] key pressed, click multiple configuration sheets you want to

select.

� Changing the order
You can change the order of configuration sheets under the same function (Data

transmit, Module setup, etc.).

• Operation with the menu (toolbar)

(1) Select a configuration item in the project view.

(2) To move the cursor one line up, select [Move up] from [Edit] in the main menu.

(3) To move the cursor one line down, select [Move down] from [Edit] in the main

menu.

� Changing the group name
You can change the configuration sheet name.

• Procedures

(1) Select a configuration sheet in the project view.

(2) Select [Change name] from the pop-up menu (or [Change name] from

[Config] on the main menu).

>> The “Change Name” window will appear.

(3) To change the name, input a group name in the “name setup” box.

(4) To change the icon, click [Icon Selection] to display a pull-down menu. Select

the icon you want to change.

(5) Click the [OK] button.

Handling Precautions

• Up to 32 characters can be input.

• You can change the icon only when [data transmit] is selected.

• Icons are intended to identify the process contents of each configura-
tion. Changing the icon (e.g., read → write) will not change the under-
lying operation.
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8-5-3 Function configuration tab sheet
Each function sheet is displayed as a tab sheet in list format.

� Screen structure

� Icon selection
Selects the icon that is displayed in the project view. Only the icons for data trans-

mission can be selected (changed) by the user. 

Depending on the desired process, select one of the following icons:

Normal

Read

Write

Read/Write

To create a new sheet, select the “Standard” icon.

For processes other than data transmission, the following icons are used. The icons

cannot be changed. 

• Module setup : Write

• Internal event : Read

• Logging functions : Read

Handling Precautions
• Icons are intended to identify the process contents of each configura-

tion. Changing the icon (e.g., read → write) will not change the under-
lying operation.

� Name setup
Displays the group name. 

Up to 32 characters can be input.

� Size setup
When using the CMC15GD01 advanced model, the size of the backup memory

used for trends, data logs, and event logs is displayed.

The size used for each group can be changed using the track bar.

The usage ratio is displayed on the bar graph. If usage exceeds the upper limit, it is

displayed in red.
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Light green (light red):  size used for the target group.

Dark green (dark red):  size used for other groups.

The track bar can be moved in the settable area. The upper limit value of the track

bar setting is updated if any of the following occurs:

• The sheet is opened.

• An attribute is changed.

• Operation settings are changed.

• Tab sheet is changed.

• If the attribute is changed directly or if the setting already exceeds the upper

limit when the paste, cut, or delete operations are used in the project tree view,

the size which is set at this time is used as the upper limit.

� Attribute 
Basic operations (startup conditions or notification process) of the group process

are listed.

The contents you can set up may vary depending on the type of function.

For details, refer to 

each function stated in section 9-3, Basic Function Configuration.

� Operations
Operations related to the process to be executed by the group are displayed in list

format.

The contents you can set up may vary depending on the type of function.

For details, refer to 

each function stated in section 9-3, Basic Function Configuration.

Note
The background of a cell having a configuration error is displayed in light red.

The background of a cell having a blank initial value or for which no value has

been input is displayed in light yellow.

� Operating procedures
� Clear

• Procedures

(1) Select a line in the configuration list.

(2) Select [Clear] from the pop-up menu (or [Clear] from [Edit] on the main menu).

� Insert line
• Procedures

(1) Select a line in the operations list.

Clicking the fixed cell with the desired No. will select the line.

(2) Select [Insert line] from the pop-up menu (or [Insert line] from [Edit] on the

main menu).

Note
If multiple lines are selected before the Insert line command is executed, an

equal number of blank lines is inserted before the top line of the selected area.

Chapter 8. GATEWAYEDITOR



8-23

� Delete line
• Procedures

(1) Select a line in the operations list.

Clicking the fixed cell with the desired No. will select the line.

(2) Select [Delete line] from the pop-up menu (or [Delete line] from [Edit] on the

main menu).

� Search
• Procedures

(1) Select [Search] from [Edit] on the main menu.

>>The following palette is displayed below the operations list:

(2) Input a character string to be searched for in the [Input search character
string] box.

(3) To search downward, click the [Next] button.

To search upward, click the [Prev] button.

(4) To exit the search process and close the palette, click the [X] button.

Handling Precautions
The character string in the cell must match the search string perfectly.

Note
When a cell area has been specified beforehand, the search is executed only in

the specified area.
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� Replace
• Procedures

(1) Select a line in the operations list.

Clicking the fixed cell with the desired No. will select the line.

>>The following palette is displayed under the list:

(2) Select [Delete line (N) ] from the pop-up menu (or [Delete line] from [Edit] on

the main menu).

(3) Input the character string to be replaced in the [Input replace character string]
box.

(4) When the [Exec] button is clicked, the cursor moves to the first cell containing

a matching character string.

(5) Click the [Exec] button again. The character string is replaced, and the cursor

moves to the next cell with a matching character string.

(6) If the [All] button is clicked, all matching character strings in the operations list

are replaced.

(7) To exit the replace process and close the palette, click the [X] button.

Handling Precautions
The character string in the cell must match the search string perfectly.

Note
• If you do not wish to replace the character string in a particular cell, you can

skip it without replacement by clicking the [Next] or [Prev] button. The cur-

sor will move to the next cell that contains a match, without making a

replacement.

• When a cell area has been specified beforehand, replacements are made only

in the specified area.
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8-5-4 Module selection palette and address selection palette
Models connected in the module constitution and their addresses are displayed in list format.

� Screen structure
� Base page

� Favorites 
Favorites lists contain data that the user uses frequently. A favorites list or multiple

lists can be created for each model, making data easily available when inputting

addresses into configuration sheets. 
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� Model selection
Connected modules are displayed in tree view format. You can select multiple

items in the same layer. Selection of multiple items in the tree view is done in the

same way as selection of multiple configuration items in the project view.

� Favorites selection
If multiple favorites lists are registered for one model, you can select the one you

wish to display in the address list selection area from this drop-down list.

� Favorites editing
Displays the Edit Favorite List window, which allows you to edit the favorites for

the selected model.

� Base/favorites change-over
If “Base” is selected, all addresses for  the selected module are displayed in the

address list selection area. If “Favorite” is selected, only addresses registered in the

favorites list are displayed.

� Device type selection
The device type selection is displayed only when “Base” is selected in the

base/favorite change-over box. The contents of the items displayed for device type

selection vary depending on the selected model.

� Narrowing setup
The narrowing setup is displayed only when “Base” is selected in the base/favorite

change-over area. Only addresses including the specified character string are dis-

played in the address list selection area.

Note
GatewayEditor favorites can be shared by users logged on to the personal com-

puter. For example, if a user who logs on as “tanaka” creates a favorites list,

another user who logs on as “suzuki” can use the same favorites.

Handling Precautions
GatewayEditor favorites are saved when you exit GatewayEditor. Note
that if two instances of GatewayEditor are running, the favorites of the
GatewayEditor instance that is exited last will overwrite the previously
saved favorites.
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(1)Host station (PLC, etc.) and general communication module
Select a device type and scroll the address with the up or down button in the device

area. Additionally, you can input an address directly.

(2)Slave station (SDC-series, DMC10, CMQ-V, etc.)

As you select the next item, you can change the address that is displayed in the

address selection list.

• Bit/Word

• RAM/ROM

Handling Precautions

Some modules, such as temperature controllers, allow you to select
whether to write to RAM or to ROM (EEPROM). When writing to the
ROM is selected, the written value is saved even after the power has
been turned ON again, but the number of write cycles is limited. For
details, refer to the user's manual for the relevant module.
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� Address list selection

Addresses selected in the module selection area are displayed in list format.

One of the icons below is displayed to the left of each address item.

: Data can be read or written from/to the address.

: Data can only be read from the address.

: Data can only be written to the address.

For items registered as favorites at the displayed address, a heart ( ) is shown to

the left of the icon.
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� Operating procedures
� Drag & Drop

By dragging an item from the address list selection area and dropping it into the

function configuration tab sheet, you can set up addresses easily.

• Procedures

(1) Select a desired module for input in the model selection area.

(2) Select an address to be input in the address list selection area.

(3) Press the left mouse button on the selected item and keep it pressed while mov-

ing the mouse cursor to the desired input position in the operations list.

(4) Release the mouse button on an item in the operations list, to which an address

is input.

� Copy & Paste
You can input information selected in the address list onto the function configura-

tion tab sheet using the copy and paste function.

(1) Select a desired module for input in the model selection area.

(2) Select an address to be input in the address list selection area.

(3) Select [Copy] from the pop-up menu. Or, select [Edit] → [Copy] from the main

menu.

(4) On the item in the operations list, to which you wish to input and address, select

[Paste] from the pop-up menu, or select [Paste] from [Edit] on the main menu.
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� Setting up narrowing conditions
By narrowing down the items displayed in the address list selection area, you can

find a desired address easily.

(1) Select the desired module in the model selection area.

(2) Select “Base” in the Base/Favorite change-over area.

(3) In the [Narrowing character string setup] box, input a word to refine the list

of items shown.

(4) Click the [Exec] button or press the [Enter] key.

The list is refined, and only addresses containing the search term are displayed

in the address list. 

(5) Click the [Reset] button or click the [Exec] button with the [Narrowing char-
acter string setup] box blank to cancel the narrowing search term.

Note
• You can input multiple search terms separated by a space in the [Narrowing

character string setup] box. Refinement of the list is done with an AND

relation between the search terms.

• When narrowing is cancelled, the list reappears as it was before narrowing

began. If a different model is selected or the device type is changed, narrow-

ing is cancelled.

� Adding an address to the favorites
To add an address that is displayed in the “Base” area of the address selection list to

the favorites list for any model, follow the steps below.

(1) Select the desired module in the model selection area.

(2) Select “Base” in the Base/Favorite change-over area.

(3) Select an address you want to add to the favorites list.

(4) Select [Add to favorite] from the pop-up menu or select [Add to favorite] from

[Address List] on the main menu.

Note
• Favorites can be registered for each model. If the same model is assigned to

multiple channels, the favorites list can be used on all of them.

• Select a desired favorites list from the favorites selection area only if multiple

favorites lists exist for one model. by default, the address will be registered to

FAVORITE.
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� Deleting an address from a favorites list
To delete an address displayed as a favorite in the address selection list, follow the

steps below.

(1) Select the desired module in the model selection area.

(2) Select the address you want to delete from the favorites list.

(3) Select [Delete to favorite] from the pop-up menu or select [Delete to favorite]
from [Address List] on the main menu.

� Rearranging addresses
• Sorting addresses

You can sort addresses by the icon column, name column, or address column in the

icon address list selection area.

• Procedures

(1) Click the fixed cell at the top of any column in the address list selection area.

(2) The listed data is sorted in ascending order.

(3) Click the fixed cell again to sort the data in descending order.

• Moving up or down
Items in the address list selection area can be moved up or down by following the

steps below.

(1) Select the item you want to move.

(2) Select [Move up] from the pop-up menu or from [Edit] on the main menu.

(3) Select [Move Down] from the pop-up menu or from [Edit] on the main menu.

(4) The selected item will move up or down.

• Editing the favorites list

Favorites lists for one model can be added, deleted, or renamed in the Edit Favorite

List window.

To open the Edit Favorite List window, click the [Edit Favorite List] button, select

[Edit Favorite List] from the pop-up menu, or select [Edit Favorite List] from

[Address List] on the main menu.
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• Selected model name

The name of the model connected to the favorites list is displayed. You cannot edit

the model name.

• Favorite list

The list of favorites registered for the selected model is displayed.

Note
• One or more favorites lists must be defined for each model.

• FAVORITE is the favorites list defined for each model by default. If you do

not make changes to the favorites setup, favorites are added to FAVORITE.

• Add
• Procedures

(1) Click the [Add...] button.

>> The following Add list window will appear:

(2) In the name setup box, input the name of the favorites list you wish to create.

(3) Click [OK]. A new favorites list is then added.

• Delete
• Procedures

(1) In the list of favorites lists, select the one you wish to delete.

(2) Click the [Delete] button.

>> A deletion confirmation dialog box will appear.

(3) Click the [OK] button to delete the selected favorites list.
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• Change Name
• Procedures

(1) In the list of favorites lists, select the list you wish to rename.

(2) Click the [Name...] button or double-click the favorites list you have selected in

the favorites list. The Change Name window will appear.

(3) Input a new name in the name setup box.

(4) Click the [OK] button. The name of the favorites list is then changed.

� Selecting multiple addresses
• Contiguous item selection

• Procedures

Selection with the mouse

(1) Select the first of the contiguous items in the address list selection area.

(2) While pressing the [Shift] key, click the last of the items you wish to select.

Selection with the keyboard

(1) Select the first of the contiguous items in the address list selection area.

(2) While pressing the [Shift] key, press the [↑] or [↓] key to select contiguous

items.

• "Random" selection

• Procedures

Selection with the mouse

(1) Select an item on the address list selection.

(2) While pressing the [Ctrl] key, click further items you wish to add or delete.
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• Multiple-selection operation
When selecting multiple modules or addresses to set them, the node addresses or

addresses are allocated automatically. To allocate node addresses or addresses, fol-

low the steps below.

Example 1.  Selecting multiple addresses

If you select communication CH“4” and address “1001 to 1003” of the module

with node “1” from the module selection:

(1) Selection status

(2) Results after dragging and dropping on the function configuration tab sheet.

Example 2.  Selecting multiple modules

If you select communication CH “4” and address “1001” of the module with node

“1 to 3” from the module selection:

(1) Selection status
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(2) Results after dragging and dropping on the function configuration tab sheet.

Example 3.  Selecting multiple addresses and modules

If you select communication CH “4” and address “1001 to 1003” of the module

with node “1 to 3” from the module selection:

(1) Selection status

(2) Results after dragging and dropping on the function configuration tab sheet.
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8-5-5 List of configuration errors

If there is any incorrect configuration in the function configuration tab sheet, the

contents of the error are displayed in the list of configuration errors.

The following information is displayed for errors:

• Configuration type (data transmission or module setup, etc.)

• Group name (only when the name is set.)

• Error details

Configuration errors include the following:

• The address is incorrect. (The address of the CPL is set for the communication

channel to which the MELSEC-Q is assigned.)

• The numeric value exceeds the allowable input range.

• No data was input.

If there is a configuration error, the configuration cannot be transmitted to the

CMC15G.

To move to the portion having the configuration error, follow the steps below.

(1) Double-click the line for which the error is displayed or select the relevant line

and press the [Enter] key.

(2) The target configuration sheet is displayed and the focus is moved to the cell, in

which the error occurs.

Note
• Up to 300 errors can be displayed at once.
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9  -  1 Creating a Project

A project is a group of functional settings for the CMC15G. Once a project has been downloaded to the main unit,

CMC15G functions are available.

9-1-1 Creating a new project
• Procedures

(1) Select [Create new project] from the [File] menu.

>> The Module Constitution window will appear.

(2) Set up the module so that it is connected to the CMC15G.

9-2-1, Module constitution (on page 9-9)

(3) Click the [OK] button.

>> A new project will be created.

Note
You can change the module constitution settings later. Therefore, it is not nec-

essary to make all the settings completely at first.

9-1
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9-1-2 Opening a project
• Procedures

(1) Select [Open project] from the [File] menu.

>> The Module Constitution window will appear.

(2) Select the name of the file you want to open. (To specify a file name directly,

input a file name in the [File name] box.)

(3) Click the [Open] button.

>> The project file you have specified will be opened.

Note
The default initial folder when starting up for the first time is “My Documents

\GatewayEditor\.” 

In subsequent startups, the folder selected the previous time appears as the ini-

tial folder. 

If you select a project file, you can view the comments for that project.

Open
Cancel

File name

File type
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9-1-3 Re-opening a project
• Procedures

(1) Select [Re-open project] from the [File] menu.

>> A  window showing the list of projects opened in the past appears.

(2) Click the [Open] button.

>> The project file you have specified will be opened.
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9-1-4 Saving a project
� Saving a project

• Procedures

Select [Save project] from the [File] menu.

>> The currently selected project is saved to a file.

Note
If you attempt to save a project that has not yet been saved to a file, the Save
As window will appear.

� Saving a project with a desired file name

• Procedures

(1) Select [Save project as ] from the [File] menu.

>> The Save As window appears.

(2) Open the folder to which you wish to save the project, and input the file name.

(If you want to overwrite the project onto an existing file, select the file.)

(3) Click the [Save] button.

>> The project is saved with the specified file name.

Note
The default initial folder when starting up for the first time is “My Documents

\GatewayEditor\.” 

In subsequent startups, the folder selected the previous time appears as the ini-

tial folder. 

Handling Precautions
To ensure that the project is saved properly, do not use any special
Unicode characters in the file name.
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9-1-5 Closing a project
• Procedures

Select [Close project] from the [File] menu.

>> The opened project will be closed.

Note
If you close a project you are currently editing, the following message will

appear:
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9-1-6 Checking the project information
• Procedures

Select [Project Information] from the [File] menu.

>> The Project Information window will appear.

� General

� Project name

Displays the project name.

� Type
Displays the target type applicable to the project.

� Create date

Displays the date and time when the project was created.

� Modified date
Displays the date and time when the project was saved.

� Size of project (bytes)
Displays the size of data saved to the CMC15G. If this size exceeds the maximum

size (1048000 bytes), it is displayed in red.

� Number of operations
Displays the total number of operations set for the data transmission or module

setup, etc. If the number of operations exceeds the maximum level (20000), it is

displayed in red.

� Backup memory (bytes)

Displays this information only when using the CMC15GD01 advanced model.

The size of the backup memory used for the trend, data log, and event log is shown.

If this size exceeds the maximum level (950000 bytes), it is displayed in red.

Handling Precautions
If the project size, number of operations, or backup memory exceeds
the maximum level, the project cannot be downloaded to the CMC15G.

� Comment
You can add a comment to the project. A comment can be up to 256 characters in

length.
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9-1-7 Outputting a CSV file
The contents of the project are output to a file in CSV format.

� Output contents
� Project information

� Module constitution
The following information is output by communication channel:

• Communication channel configuration

• Connected module configuration

� Option configuration

� Basic function configuration
The configuration of the following functions is classified into operation settings

and operations. They are output by group. However, note that a function not in use

is not output.

• Data transmission

• Module setup

• Internal event
The contents which are output are the attribute list and the operations list for each
function.

Project name File name of project
Model No. CMC15G*01A00
Comment Comment about the project

Parameters Value
CH 1 to 4
Communication driver Driver name
Band rate 600 to 115200 bps
Data length 8bits/7bits
Parity None/even/odd
Stop bit 1bit/2bits
Retry 0 to 15
Time-out 1 to 255 (100ms)

No. Name CH Node Sub
1 Model 1 to 4 0 to 127 0 to 127
2 Model 1 to 4 0 to 127 0 to 127
… …………

Parameters Value
Node address 1 to 126
Startup delay Disable/Enable
Delay time (s) 1 to 360
Protect log table Disable/Enable
Password **********
Trigger device Data transmission Disable/Enable
initialization Module setup Disable/Enable

Date & time adjustment Disable/Enable
Captured trends Disable/Enable
Data log Disable/Enable

Notification device Data transmission Disable/Enable
initialization Module setup Disable/Enable
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� Logging function configuration
The configuration of the following functions is classified into operation settings

and operations. They are output by group. However, note that a function not in use

is not output.

• Trend

• Data log

• Event log

The contents which are output are the attribute list and the operations list for each

function.

� Extended function configuration
The configuration of the following functions is output. However, note that a func-

tion not in use is not output.

• Internal status notification

• Communication error notification

• Date & time adjustment

The contents which are output are the attribute list and the operations list for each

function.

� Outputting to a CSV file
(1) From the [File] menu, select [Export] → [CSV file].

>> The Save As window appears.

(2) Open the folder to which you wish to save the project, and input the file name.

(If you want to overwrite the project onto an existing file, select the file.)

(3) Click the [Save] button.

>> A CSV file is saved with the specified file name.

Note
The default initial folder when starting up for the first time is “My Documents
\GatewayEditor\” In subsequent startups, the folder selected the previous time

appears as the initial folder.

Save
Cancel
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9  -  2 System Configuration

9-2-1 Module constitution
If you select a module to be connected to any channel of the CMC15G, you can set

up various kinds of processes.

To display the Module Constitution screen, double-click Constitution in the project

view or select [System Configuration] → [Constitution] from [Config] on the

main menu.

� Screen layout

� Module selection palette

Modules you can connect to the CMC15G are displayed by type.

When clicking a desired type, the list of modules to be connected is displayed

under the selected type. You can assign a module displayed in the list to the module

constitution view through the mouse drag & drop operation.

� Module constitution view
Modules connected to the CMC15G are displayed hierarchically.

Constitution column:  Displays the module constitution.

Node column:  Displays the node address of the connected module.

Various operations are possible:

• Addition of new modules (up to 500) from the module selection palette

• Node address change for any connected module 

• Module configuration editing (copy/paste/delete/move) in the module constitu-

tion view

• Selection of multiple items in the same hierarchy

� Communication channel setup area

This area displays the communication configuration of the communication chan-

nels (CH1 to CH4). 

This configuration is common to the modules connected to the same communica-

tion channel.

Toolbar

Cancel

Communication
channel setup area

Module selection
palette

Module constitution
view

OK
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� Toolbar
Clicking a button on the toolbar will execute the corresponding editing function in

the module constitution view.

� OK button / Cancel button
Clicking the [OK] button will close the Module Constitution window with the con-

figuration made effective.

On the contrary, clicking the [Cancel] button will close the Module Constitution

window with the configuration made ineffective.

� Operating procedures
• Procedures

(1) Select a module you want to connect from the module selection palette and add

it to the module constitution view.

(2) Set up the communication channel assigned to the module.

(3) If necessary, change the node address of the connected module.

(4) Click the [OK] button.

>> The module selection palette in the main window is then changed.

� Adding a connected module
• Adding a module by drag & drop

(1) Display a module you want to connect on the module selection palette and

select it.

(2) Move the mouse cursor onto the module you want to connect on the module

selection palette. Press and hold the left mouse button, and then move the

mouse cursor into the module constitution view.

(3) Move the mouse cursor to location to which you would like to connect in the

module constitution view and release the left mouse button.

(1) Select a model.

(2) Drag the selected model
with the mouse.

(3) Release the left mouse button.
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• Adding a module by double-clicking

(1) Select the place in the module constitution view where you want to connect a

module.

(2) Double-click the module you want to connect on the module selection palette.

Handling Precautions

• Up to 500 modules can be connected.

• When you connect a module to a communication channel, the commu-
nication driver is set up automatically.

If a module is already connected to a channel, any other module con-
nected to that channel must use the same driver. A module that does
not use the same driver cannot be connected.

• The SDU10 can connected only as a slave station to the DMC10.

• When using the SDU10 in THROUGH mode (with node address “0”),
do not add the SDU10 to the communication channel in the module
constitution view, but rather add the DMC10.

� Communication channel configuration
Communication channels can be configured using the Communication channel

setup area.

Communication driver
A communication driver is automatically set up when the module is connected.

If no modules are connected to a channel, the serial slave station communication

driver is used.

Band rate (bps)
Select either 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600, or 115200.

The initial value may vary depending on the type of connected module.

Data length
Select “7 bits” or “8 bits.” The initial value is “8 bits.”

Parity
Select “none”, “even”, or “odd.” The initial value is “even.”

Stop bit
Select “1 bit” or “2 bits.” The initial value is “1 bit.”

Retry
Input a value ranging from 0 to 15. The initial value is “3.”

Time-out time (100 ms)
Input a value ranging from 1 to 255 (0.1 s to 25.5 s). The initial value is “20” 

(2 s).
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� Changing a node address
• Procedures

(1) Select the connected module whose address you want to change in the module

constitution view, right-click to display the pop-up menu and select [Change
node address]. Or, select the module and click on the toolbar.

>> The Node Address window will appear.

(2) Input a node address and click the [OK] button.

Handling Precautions
You cannot specify a node address already in use.

The available node address range is “0” to “127.” You cannot select an
address beyond this range.

Note
If you construct a hierarchical structure using the CMC10B in the module con-

stitution view, you can select multiple modules in the module constitution view

only within the same hierarchy. You cannot select multiple modules across dif-

ferent hierarchies.
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9-2-2 Option configuration
Option configuration is used to set up the CMC15G main unit.

To open the Option Configuration window, double-click [Option (O)] in the pro-

ject view or select [System Config (S)] → [Option (O)] from [Config (C)] on the

main menu.

� General

Standard model (CMC15GS01) Advanced model (CMC15GD01)

� Node address of main unit
Specifies a node address for the CMC15G main unit.

This node address is used when the CMC15G serves as a slave station and commu-

nicates with the host computer.

The available range of nodes is 1 to 126. The initial value is “1.”

� Startup delay
This setting is intended to delay startup of the CMC15G for a specified amount of

time after the mode has been changed to RUN. If you wish to start CMC15G oper-

ation immediately after the mode is changed to RUN, do not check the check box.

By default the check box is not checked.

To enable startup delay, check the check box and set a delay time in seconds. The

settable range is 1 to 360 s. The initial value is “1.”

� Protect log table
This protect log table box is shown only when using the CMC15GD01 advanced

model. This function protects recorded data collected by the CMC15G with a pass-

word.

If you check the [Protect log table] check box, you can input a password. By

default the [Protect log table] check box is not checked.

Up to 10 alphanumeric characters can be input for the password.

Note
• If the password is set, you must input it in order to read or delete recorded

data using the LogViewer.
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� Initialization

Standard model (CMC15GS01) Advanced model (CMC15GD01)

� Trigger device initialization 
You can initialize a trigger device whose status has changed when starting up the

process in the following functions:

• Data transmit (only when the trigger is activated)

• Module setup

• Date & time adjustment

• Captured trends function (CMC15GD01 advanced model only)

• Data log (CMC15GD01 advanced model only)

By default all check boxes are checked.

� Notification device initialization
You can initialize a notification device whose status has changed when starting up

the process in the following functions:

• Data transmit (only when the trigger is activated)

• Module setup

By default no boxes are checked.
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9  -  3 Basic Function Configuration

9-3-1 Data transmit
Data is transmitted from the connected module to other connected modules either periodically or when a change in

the trigger device is detected.

� Screen layout

� Execute condition
Specifies conditions for starting the group process. Double-click the box in the

Value column and select any of the following items from the drop-down list:

• Cyclic (Auto)

• Cyclic (Fixed)

• Trigger (OFF → ON)

• Trigger (ON → OFF)

The initial value is “Cyclic (Auto).”

Priority
This configuration box is shown when “Cyclic (Auto)” is selected in the [Execution

condition] box. 

The configuration box specifies the priority for the group process startup. Select

either of the settings shown below from the drop-down list.

• Normal

• High

The initial value is “Normal.”

Cyclic (s)
This configuration box is shown when “Cyclic (Fixed)” is selected in the

[Execution condition] box. 

Specifies the cycle time (in seconds) for starting up the group process. The allow-

able range is 1 to 7200 s.

The initial value is “10.”
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Trigger device

This setting specifies a trigger device for starting the group process. 

The initial value is blank.

� Completion notification

Specifies whether or not to notify the host station upon completion of the group

process.  The configuration box specifies the priority for the group process startup.

Select either of the settings shown below from the drop-down list.

• Disable

• Enable

The initial value is “Disable.”

Notification device

A notification device can be set up if “Enable” is selected in the [Completion noti-

fication] box. 

This setting specifies the device that is notified on the host station. 

The initial value is blank.

� Error notification
Specifies whether or not to notify the host station if an error occurs in the group

process. The configuration box specifies the priority for the group process startup.

Select either of the settings shown below from the drop-down list.

• Disable

• Enable

The initial value is “Disable.”

Notification device

A notification device can be set up if “Enable” is selected in the [Completion noti-

fication] box. 

This setting specifies the device that is notified on the host station. The initial value

is blank.

� Effective change
Specifies whether, after the group process is triggered, it automatically runs, or

whether its execution is dependent upon the status of a monitor device. The config-

uration box specifies the priority for the group process startup. Select either of the

settings shown below from the drop-down list.

• Always effective

• Effective at bit status ON

• Effective at bit status OFF

The initial value is “Always effective.”
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Monitor device

If the [enabled-disabled setting] is “Effective at bit status ON” or “Effective at bit

status OFF,” a monitor device must be designated. This is the bit on the host station

that will determine whether the process is enabled or disabled.

The initial value is blank.

� Sender setup

Specifies a sender device. The data read from this device is written to the receiver

device. 

Select a device on the connected module.

The initial value is blank.

For sequential execution, right-click the line No. you want to synchronize and

select [Insert sync line] or input “SYNC” (uppercase characters) in the CH cell at

the left end of the line.

You can specify data to be transmitted directly in the data transmission. The input

range may vary depending on the data format and size. The settable ranges are as

follows:

Signed decimal values (with uppercase character “K” before the numeric value):

• 1 word: K - 32768 to K 32767

• 2 words: K - 2147483648 to K2147483647

Hexadecimal values (with character “#” before the numeric value)

• 1 word: #0000 to #FFFF

• 2 words: #00000000 to #FFFFFFFF

To directly specify data, leave the CH and Node fields blank.

� Receiver setup
Specifies a receiver device. The data read from the sender is written to this device.

Select a device on the connected module.

The initial value is blank.

� Size
Specifies the number of words of data to transmit at one time.

In the case of modules supporting continuous read and write using the communica-

tion command, the size is determined by the same communication command.

Select either of the items shown below from the drop-down list.

• 1 word

• 2 words

The initial value is “1 word.”
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� Notes
The names of devices registered in the address list of the devices set in the sender

setup and receiver setup are displayed as reference information.

Handling Precautions
• If multiple groups use the same trigger, do not check the check boxes

in the “Initialize trigger device” area. If initialization is enabled, groups
may not detect a change in the trigger device, depending on the trig-
ger initialization timing.

• If you use a special contact (SM900.0 to SM999.F) as a trigger device,
do not check the check boxes in the “Initialize trigger device” area. If
initialization is enabled, trigger device initialization will fail since writing
is not possible.
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9-3-2 Module setup
If a change in the trigger device is detected, the initial settings (fixed data) are transmitted to the connected modules.

� Screen layout

� Execute condition
Specifies conditions for starting the group process. Select any of the following

items from the drop-down list:

• Trigger (OFF → ON)

• Trigger (ON → OFF)

The initial value is “Trigger (OFF → ON).”

Trigger device

This setting specifies a trigger device for starting the group process. The initial

value is blank.

� Completion notification
Specifies whether or not to notify the host station upon completion of the group

process. The configuration box specifies the priority for the group process startup.

Select either of the settings shown below from the drop-down list.

• Disable

• Enable

The initial value is “Disable.”

Notification device

A notification device can be set up if “Enable” is selected in the [Completion noti-

fication] box. 

This setting specifies the device that is notified on the host station. 

The initial value is blank.
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� Error notification
Specifies whether or not to notify the host station if an error occurs in the group

process. The configuration box specifies the priority for the group process startup.

Select either of the settings shown below from the drop-down list.

• Disable

• Enable

The initial value is “Disable.”

Notification device

A notification device can be set up if “Enable” is selected in the [Completion noti-

fication] box. 

This setting specifies the device that is notified on the host station. The initial value

is blank.

� Effective change
Specifies whether, after the group process is triggered, it automatically runs, or

whether its execution is dependent upon the status of a monitor device. The config-

uration box specifies the priority for the group process startup. Select either of the

settings shown below from the drop-down list.

• Always effective

• Effective at bit status ON

• Effective at bit status OFF

The initial value is “Always effective.”

Monitor device

If the [Effective change] is “Effective at bit status ON” or “Effective at bit status

OFF,” a monitor device must be designated. This is the bit on the host station that

will determine whether the process is enabled or disabled.

The initial value is blank.

� Write destination setup
Specifies a device at the write destination.

Enter a device on the connected module.

The initial value is blank.

For sequential execution, right-click the line No. you want to synchronize and

select [Insert sync line] or input “SYNC” (uppercase characters) in the CH cell at

the left end of the line.

� Data format
Determines the type of data transmitted.

Select any of the following items from the drop-down list:

• Signed decimal

• Unsigned decimal

• BCD

• HEX

• Floating-point

The initial value is “Signed decimal.”
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� Size
Specifies the size of the transmitted data. Select either of the choices below from

the drop-down list. (If “Floating-point” is selected in the Data format field, you can

select only “2 words.”)

• 1 word

• 2 words

The initial value is “1 word.” (If “Floating-point” is selected in the data format

field, “2 words” is the only selection available.)

� Data
Specify the type of data to be transmitted in module setup. The input range may

vary depending on the data format and size. The settable ranges are:

Signed decimal values

• 1 word: – 32768 to +32767

• 2 words: – 2147483648 to +2147483647

Unsigned decimal

• 1 word: 0 to 65535

• 2 words: 0 to 4294967295

Hexadecimal values

• 1 word: 0000 to FFFF

• 2 words: 00000000 to FFFFFFFF

BCD

• 1 word: 0000 to 9999

• 2 words: 00000000 to 99999999

Floating-point

–3.402823E+38 to –1.175494E-38, 0, +1.175494E-38 to +3.402823E+38

The initial value is “0.”

� Notes
The names of devices registered in the address list of the devices set in the write

destination setup are displayed as reference information.

Handling Precautions
• If multiple groups use the same trigger, do not check the check boxes

in the “Initialize trigger device” area. If initialization is enabled, groups
may not detect a change in the trigger device, depending on the trig-
ger initialization timing.

• If you use a special contact (SM900.0 to SM999.F) as a trigger device,
do not check the check boxes in the “Initialize trigger device” area. If
initialization is enabled, trigger device initialization will fail since writing
is not possible.
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9-3-3 Internal event function
This function monitors the bit or numeric value device on the connected module to

determine whether to turn ON/OFF the corresponding bit inside the CMC15G.

� Screen layout

� Execute condition
Specifies conditions for starting the group process. Select any of the following

items from the drop-down list:

• Cyclic (Auto)

• Cyclic (Fixed)

The initial value is “Cyclic (Auto).”

Priority
This configuration box is shown when “Cyclic (Auto)” is selected in the [Execution

condition] box. 

The configuration box specifies the priority for the group process startup. Select

either of the settings shown below from the drop-down list.

• Normal

• High

The initial value is “Normal.”

Cyclic (s)
This configuration box is shown when “Cyclic (Fixed)” is selected in the

[Execution condition] box. 

Specifies the cycle time (in seconds) for starting up the group process. The allow-

able range is 1 to 7200 s.

The initial value is “10.”
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� Output device
Specifies the device to which the results of the internal event function are output.

Select any of the following from the drop-down list:

EM000.0 to EM001.3

The initial value is “EM000.0.”

� Logical type
Specifies the type of logical connection to use when relating the device status at

each comparison source.

Select either setting shown below from the drop-down list.

• Or

• And

The initial value is “Or.”

� Effective change
Specifies whether, after the group process is triggered, it automatically runs, or

whether its execution is dependent upon the status of a monitor device. The config-

uration box specifies the priority for the group process startup. Select either of the

settings shown below from the drop-down list.

• Always effective

• Effective at bit status ON

• Effective at bit status OFF

The initial value is “Always effective.”

Monitor device

If the [enabled-disabled setting] is “Effective at bit status ON” or “Effective at bit

status OFF,” a monitor device must be designated. This is the bit on the host station

that will determine whether the process is enabled or disabled.

The initial value is blank.

� Comparison source setup

Specifies comparison source devices.

Select a device on the connected module.

The initial value is blank.
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� Condition
Specifies necessary conditions for judging the status of devices. Select any of the

following items from the drop-down list:

• Bit ON

• Bit OFF

• Compare

The initial value is “Bit ON.”

Note
If a word device is specified as the source to read, any value other than “0” is

handled as “Bit ON.”

� Data format
The Data format column is valid when “Compare” is set in the condition field.

It specifies the data type.  Determines the type of data transmitted.

Select any of the following items from the drop-down list:

• Signed decimal

• Unsigned decimal

• BCD

• HEX

• Floating-point

The initial value is “Signed decimal.”

� Size
This Size column is valid when “Compare” is selected in the condition field. It

specifies the amount of data to read. Select either of the choices below from the

drop-down list. (If “Floating-point” is selected in the Data format field, you can

select only “2 words.”)

• 1 word

• 2 words

The initial value is “1 word.” (If “Floating-point” is selected in the Data format

field, “2 words” is the only selection available.)

� Compare 1
The Comp 1 column is valid when “Compare” is selected in the condition field.  It

specifies the type of comparison to use for numeric values. It specifies the amount

of data to read. Select either of the choices below from the drop-down list.

• > : The value of comparison source device is larger than value 1.

• >= : The value of comparison source device is value 1 or more.

• < : The value of comparison source device is smaller than value 1.

• <= : The value of comparison source device is value 1 or less.

• == : The value of comparison source device is corresponding to value 1.

• != : The value of comparison source device is not corresponding to value 1.

The initial value is “>.”
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� Value 1
Specifies a numeric value to use for comparison.

The input range may vary depending on the data format and size.

The settable ranges are as follows:

Signed decimal values

• 1 word: – 32768 to +32767

• 2 words: – 2147483648 to +2147483647

Unsigned decimal

• 1 word: 0 to 65535

• 2 words: 0 to 4294967295

BCD

• 1 word: 0000 to 9999

• 2 words: 00000000 to 99999999

Hexadecimal values

• 1 word: 0000 to FFFF

• 2 words: 00000000 to FFFFFFFF

Floating-point

–3.402823E+38 to –1.175494E-38, 0, +1.175494E-38 to +3.402823E+38

The initial value is “0.”

� Compare 2
The comp 2 column is valid if the following conditions are met:

• “Compare” is selected in the condition field.

• A symbol other than “>=” and “>” is selected in the comp 1 field.

Comp 2 specifies the type if a second numeric value is to be compared. When the

conditions in the comp 1 and comp 2 fields are satisfied, the contact of the output

device is turned ON. It specifies the amount of data to read. Select either of the

choices below from the drop-down list.

• - - - : a second numeric value is not to be compared.

• <= : The value of comparison source device is value 2 or less.

• <   : The value of comparison source device is smaller than value 2.

The initial value is “- - -.”
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� Value 2
The value 2 column is valid when a symbol other then “- - -”. is set in the comp 2

column.

Value 2 specifies the numeric value used for the comparison.

The input range may vary depending on the data format and size.

The settable ranges are as follows:

Signed decimal values

• 1 word: – 32768 to +32767

• 2 words: – 2147483648 to +2147483647

Unsigned decimal

• 1 word: 0 to 65535

• 2 words: 0 to 4294967295

BCD

• 1 word: 0000 to 9999

• 2 words: 00000000 to 99999999

Hexadecimal values

• 1 word: 0000 to FFFF

• 2 words: 00000000 to FFFFFFFF

Floating-point

–3.402823E+38 to –1.175494E-38, 0, +1.175494E-38 to +3.402823E+38

The initial value is “0.”

� Notes
The names of devices registered in the address list of the devices set in the read-out

source setup are displayed as reference information.
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9  -  4 Logging Function Configuration

9-4-1 Trend
Trend functions can be set up only on the CMC15GD01 advanced model.

Trend functions record numeric data from the host station and slave station in the

internal memory of the CMC15G at constant intervals. There is a continuous trend

function and a captured trends function.

� Screen layout

� Size setup
You can change the size of the backup memory used for the set group by moving

the track bar.

For a continuous trend, adjust the number of records.

For the captured trends function, set the total number of pre-trigger records and

post-trigger records. The change ratio is a percentage of the value input in the

[Number of pre-trigger records] or [Number of post-trigger records] box.

Note
• The size may be affected by the size of the backup memory used by the main

unit. The high limit may vary depending on the settings for trend, data log,

and event log.

Set the size while carefully checking the size setup bar graph.

� Term
The time in which the continuous trend save process is completed or the time after

which the trend data is saved as one capture is displayed. This time is automatically

calculated from the cycle time and the number of records.

� Cycle time (sec)

Specifies the cycle time (in seconds) for starting up the group process. The allow-

able range is 1 to 7200 s.

The initial value is “10.”
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� Save type
The time in which the continuous trend save process is completed or the time after

which the trend data is saved as one capture is displayed. This time is automatically

calculated from the cycle time and the number of records.

The Save type setting specifies the method of saving collected trend data. Select

from the following items on the drop-down list. Use this setting to switch between

continuous trend and captured trends functions.

• Continuous

• Trigger capture (OFF->ON)

• Trigger capture (ON->OFF)

The initial value is “Continuous.”

Number of records

Available only if “Continuous” is selected in the [Save type] box.

Specifies the number of data records to be saved.

Input a numeric value ranging from “1” to “110000.”

The initial value is “1000.”

Number of pre-trigger records

Available only if “Capture” is selected in the [Save type] box.

Specifies the number of data records to be saved before the trigger occurs.

Input a numeric value ranging from “1” to “110000.”

The initial value is “1000.”

Number of post-trigger records

Available only if “Capture” is selected in the [Save type] box.

Specifies the number of data records to be saved after the trigger occurs.

Input a numeric value ranging from “1” to “110000.”

The initial value is “1000.”

Save overwrite

Available only if “Capture” is selected in the [Save type] box.

This setting is not available for continuous trends, since the data in that case is

always saved in overwrite mode.  Select whether or not to overwrite past capture

data if the memory for captures is full.

Select either of the settings shown below from the drop-down list.

• Disable

• Enable

The initial value is “Disable.”
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Number of captures

Available only if “Capture” is selected in the [Save type] box.

Specifies how many triggers are saved.

Input a numeric value ranging from “1” to “100.”

The initial value is “1.”

Trigger device

Available only if “Capture” is selected in the [Save type] box.

Specifies a device on the host station that judges the trigger.

The initial value is blank.

� Effective change
You can specify whether, after a group process is triggered, it automatically runs,

or whether its execution is dependent upon the status of a monitor device. The con-

figuration box specifies the priority for the group process startup. Select either of

the settings shown below from the drop-down list.

• Always effective

• Effective at bit status ON

• Effective at bit status OFF

The initial value is “Always effective.”

Monitor device

If the [Effective change] is “Effective at bit status ON” or “Effective at bit status

OFF,” a monitor device must be designated. This is the bit on the host station that

will determine whether the process is enabled or disabled.

The initial value is blank.

� Name
Specifies a name for the collected trend data.

Up to 16 characters can be set.

The initial value is blank.

� Read source setup
Specifies a read source device.

Select a device on the connected module.

The initial value is blank.
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� Data format
Specifies the type of data to collect.  

Select any of the following items from the drop-down list:

• Signed decimal

• Unsigned decimal

• BCD

• HEX

• Floating-point

The initial value is “Signed decimal.”

� Size
Specifies the size of data to collect.  

Select either of the choices below from the drop-down list. (If “Floating-point” is

selected in the Data format field, you can select only “2 words.”)

• 1 word

• 2 words

The initial value is “1 word.”

� Decimal point position
Specifies the decimal point position for the collected data.

You can set the decimal point position only if “Signed decimal”, “Unsigned deci-

mal”, or “BCD” is set for the data format.

The initial value is “0” (without the decimal point).

The range you can input may vary depending on the data format and size.

Signed decimal values

• 1 word: 0 to 5

• 2 words: 0 to 10

Unsigned decimal

• 1 word: 0 to 5

• 2 words: 0 to 10

BCD

• 1 word: 0 to 4

• 2 words: 0 to 8

Note
• If the decimal point position exceeds the range when the data format or size is

changed, an error message is displayed.
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9-4-2 Data log
Data log functions can be set up only on the CMC15GD01 advanced model.

This function saves information from the host station and slave station to the inter-

nal memory of the CMC15G if a change in the specified bit is detected.

� Screen layout

� Size setup
You can change the size of the backup memory used for the set group by moving

the track bar.

For a continuous trend, adjust the number of records.

� Execution condition
Specifies conditions necessary to start up the group process. Select either of the fol-

lowing items from the drop-down list:

• Trigger (OFF->ON)

• Trigger (ON->OFF)

The initial value is “Trigger (OFF->ON).”

Trigger device
Specifies a trigger device for starting the group processing. The initial value is

blank.

Number of records
Specifies the number of data records to save.

Input a numeric value ranging from 1 to 110000. The initial value is “1000.”

Note
• The size may be affected by the size of the backup memory used by the main

unit. The high limit may vary depending on the settings for trend, data log,

and event log.

Set the size while carefully checking the size setup bar graph.
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� Effective change
You can specify whether, after a group process is triggered, it automatically runs,

or whether its execution is dependent upon the status of a monitor device. The con-

figuration box specifies the priority for the group process startup. Select either of

the settings shown below from the drop-down list.

• Always effective

• Effective at bit status ON

• Effective at bit status OFF

The initial value is “Always effective.”

Monitor device

If the [Effective change] is “Effective at bit status ON” or “Effective at bit status

OFF,” a monitor device must be designated. This is the bit on the host station that

will determine whether the process is enabled or disabled.

The initial value is blank.

� Name
Specifies a name for the collected data log.

Up to 16 characters can be set.

The initial value is blank.

� Read source setup
Specifies a read source device.

Select a device on the connected module.

The initial value is blank.

� Data format
Specifies the type of data to collect.  

Select any of the following items from the drop-down list:

• Signed decimal

• Unsigned decimal

• BCD

• HEX

• Floating-point

The initial value is “Signed decimal.”
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� Size
Specifies the size of data to collect.  

Select either of the choices below from the drop-down list. (If “Floating-point” is

selected in the Data format field, you can select only “2 words.”)

• 1 word

• 2 words

The initial value is “1 word.”

� Decimal point position
Specifies the decimal point position for the collected data.

You can set the decimal point position only if “Signed decimal”, “Unsigned deci-

mal”, or “BCD” is set for the data format.

The initial value is “0” (without the decimal point).

The range you can input may vary depending on the data format and size.

Signed decimal values

• 1 word: 0 to 5

• 2 words: 0 to 10

Unsigned decimal

• 1 word: 0 to 5

• 2 words: 0 to 10

BCD

• 1 word: 0 to 4

• 2 words: 0 to 8

Note
• If the decimal point position exceeds the range when the data format or size is

changed, an error message is displayed.
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9-4-3 Event log
Event log functions can be set up only on the CMC15GD01 advanced model.

This function saves the event, type, and time to the internal memory of the

CMC15G if an event occurs in a connected module.

� Screen layout

� Size setup
You can change the size of the backup memory used for the set group by moving

the track bar.

For a continuous trend, adjust the number of records.

� Execution condition
Specifies conditions necessary to start up the group process. Select either of the fol-

lowing items from the drop-down list:

• Cyclic (Auto)

• Cyclic (Fixed)

The initial value is “Cyclic (Auto).”

Priority

This configuration box is shown when “Cyclic (Auto)” is selected in the [Execution

condition] box. 

The configuration box specifies the priority for the group process startup. Select

either of the settings shown below from the drop-down list.

• Normal

• High

The initial value is “Normal.”
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Cyclic (s)

This configuration box is shown when “Cyclic (Fixed)” is selected in the

[Execution condition] box. 

Specifies the cycle time (in seconds) for starting up the group process. The allow-

able range is 1 to 7200 s.

The initial value is “10.”

Number of records
Specifies the number of data records to save.

Input a numeric value ranging from 1 to 110000. The initial value is “1000.”

Note
• The size may be affected by the size of the backup memory used by the main

unit. The high limit may vary depending on the settings for trend, data log,

and event log.

Set the size while carefully checking the size setup bar graph.

� Effective change
You can specify whether, after a group process is triggered, it automatically runs,

or whether its execution is dependent upon the status of a monitor device. The con-

figuration box specifies the priority for the group process startup. Select either of

the settings shown below from the drop-down list.

• Always effective

• Effective at bit status ON

• Effective at bit status OFF

The initial value is “Always effective.”

Monitor device

If the [Effective change] is “Effective at bit status ON” or “Effective at bit status

OFF,” a monitor device must be designated. This is the bit on the host station that

will determine whether the process is enabled or disabled.

The initial value is blank.

� Name
Specifies a name for the collected event log.

Up to 16 characters can be set.

The initial value is blank.

� Read source setup
Specifies a read source device.

Select a device on the connected module.

The initial value is blank.
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� Condition
Specifies a condition for event detection.

Select either of the settings shown below from the drop-down list.

･ OFF->ON

･ ON->OFF

･ OFF<->ON

The initial value is “OFF->ON.”

� Event type
Specifies an event type.

Select either of the settings shown below from the drop-down list. When reading

the data using the LogViewer, you can filter the data by event type.

• INFO (information)

• WARN (warning)

• ERR (error)

The initial value is “INFO.”
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9  -  5 Extended Function Configuration

9-5-1 Status notification

� Screen layout

This function sends a notice to the host station if the status of the CMC15G is one

of the following:

Notify running

Notify alarm battery

Notify capture exists

Notify capture full

� Effective change

Specifies whether or not the notification function is utilized.  Select either of the

settings shown below from the drop-down list.

• Disable

• Enable

The initial value is “Disable.”

� Cyclic (min)
Sets the cycle time (in minutes) for starting the group process.

The setting range is 1 to 120 minutes.

The initial value is “10.”

� Notification device
Specifies the device that is notified on the host station. 

The initial value is blank.

9-37
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9-5-2 Communication error notification

� Screen layout

If an error occurs during communication with a module connected to the

CMC15G, this function notifies the host station of the error.

� Module information
Shows the CH (channel), Node (node address), Sub (sub-address), and module

name.

� Error notification
Specifies whether or not notification of the host station is enabled.  Select either of

the settings shown below from the drop-down list.

• Disable

• Enable

The initial value is “Disable.”

� Notification device
Available only if “Enable” is selected in the Error notification field.

This setting specifies the host station device that is notified.

The initial value is blank.
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9-5-3 Date and time adjustment

� Screen layout

This function is changes the time on the CMC15G to the time specified by the host

station.

� Execute condition
Specifies the conditions for executing date and time adjustment.  Select either of

the settings shown below from the drop-down list.

• Disable

• Trigger (OFF → ON)

• Trigger (ON → OFF)

The initial value is “Disable.”

� Trigger device

Displayed if trigger (OFF → ON) or trigger (ON → OFF) is selected in the

[Execution condition] box. 

Specifies the device on the host station that is used as a trigger for date and time

adjustment.

The initial value is blank.

� Data format
Available if “Trigger (OFF → ON)” or “Trigger (ON → OFF)” is selected in the

[Execution condition] box. 

The data format setting specifies the format to use for the date and time data from

the host station device.  Select any of the following items from the drop-down list:

• Unsigned decimal

• BCD

The initial value is “BCD.”
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� Time assignment
Displayed if trigger (OFF → ON) or trigger (ON → OFF) is selected in the

[Execution condition] box.  Specifies whether year, month, day, hour, minute, and

second data set for host station devices is expressed in the upper and lower bytes of

a single device, or is expressed in individual devices.  Select either of the settings

shown below from the drop-down list.

• YM / DH / MS

• Y / M / D / H / M / S

The initial value is “YM / DH / MS.”

� Date and time
Displayed if trigger (OFF → ON) or trigger (ON → OFF) is selected in the

[Execution condition] box.  Sets one word data of each of the following items for

devices, for which the date and time of the host station are set:

• YM / DH / MS

Year/Month (Upper byte: year.  Lower byte: month)

Day/Hour (Upper byte: day.  Lower byte: hour)

Minute/Second (Upper byte: minute.  Lower byte: second)

• Y / M / D / H / M / S

Year

Month

Day

Hour

Minute

Second

The initial value is bland.

Note
The following describes the special registers for Mitsubishi Electric's PLC

clock data:

QnA, Q (Q mode) :  SD210 (Y / M), SD211 (D / H), SD212 (M / S)

A, Q (A mode) :  D9025 (Y / M), D9026 (D / H), D9027 (M /S)

FX :  D8018 (Y),  D8017 (M),  D8016 (D),  D8015 (H),  D8014 (M),  D8013

(S)
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Chapter 10 CONNECTING TO THE CMC15G WITH GATEWAYEDITOR
10  -  1 Connections

There are two ways to connect GatewayEditor to the CMC15G.

• USB mini-B connector

• Loader jack

Handling Precautions
• Never attempt to use the USB mini-B and loader jack at the same

time. Doing so may cause a malfunction.

� USB connection
Prior to using the USB connector,it is necessary to install the special device drivers

on the personal computer. Installation of the drivers can be done using "setup.exe"

on the included GatewayEditor Setup CD-ROM.

To connect with the USB connector, select [Tool] → [Environment...] and choose

"USB."

Handling Precautions
• Do not connect two or more CMC15G units to one personal computer

using USB connectors. Doing so may cause the communication to fail.

Upon first connecting the PC and CMC15G with a USB connection, the [Found
New Hardware Wizard] window will appear.

� Loader jack connection
Connect the Smart Loader Package for the temperature controller using the special

cable supplied with the GatewayEditor. However, transmission speed is limited

when connecting through the loader jack. Use of the USB connection is recom-

mended for high-speed communication.
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� For Windows XP
(1) When using Windows XP which has been updated with Service Pack 2, the

message "Can Windows connect to Windows Update to search for software?"

will appear. This driver search will take a long time. Check [No, not this time]
and click the [Next >] button.

Note
If the above window is not shown even when using Windows XP with Service

Pack 2, it will be necessary to wait a long time every time while the computer

connects to Windows Update. To avoid this, do the following:

(i)  Select [Control Panel] → [Performance and Maintenance] → [System]
to open the [System Property] window.

(ii)  Select the [Hardware] tab and click the [Windows Update] button to open

the [Connect to Windows Update] window.

(iii)  Check on [Ask me to search Windows Update every time I connect
a new device] and click the [OK] button.
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(2) The message "What do you want the wizard to do?" will appear.

Check [Install the software automatically (Recommended)] and then click

the [Next >] button.

>>Software installation begins.

(3) As the USB drivers are installed, two screens may appear.

Click the [Continue Anyway] button.
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>>When Yamatake CMC15G USB drivers have been installed completely, the fol-

lowing window will appear:

Handling Precautions
• If the installation is not completed successfully,

Incomplete installation (on page 10-5).

(4) When the completion screen appears, click the [Finish] button.

(5) Subsequently, install Yamatake CMC15G USB COM Port drivers in the

same manner as described above.

(6) When the completion screen appears, click the [Finish] button.
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(7) When all steps have been completed successfully, the message "Your new hard-

ware is installed and ready to use" appears in the lower right of the screen.

• Incomplete installation

If the message "What do you want the wizard to do?" appears as described in

step (2), check on [Install from a list or specific location (Advanced)], and

then click the [Next >] button.
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Click [Search for the best driver in these locations], and then select [Include
this location in the search:].
Click the [Browse] button to select a folder in the SLP installation directory (the

default directory is "C:\Program Files\SLP\).

For Yamatake CMC15G USB drivers, select "SLPG15\usb\usb_vcp2." For

Yamatake CMC15G USB COM port drivers, select "SLPG15\usb\usb_vcp1."

Then click the [Next >] button.

Subsequently, skip to step (4).

� For Windows 2000
When connecting the CMC15G through the USB port for the first time, the mes-

sage below will appear and the installation will begin automatically.

When both the Yamatake CMC15G USB and Yamatake CMC15G USB COM

Port drivers have been installed, the installation is complete.
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10  -  2 Communication

10-2-1 Communication status

� Screen layout

� Process type
The process type for the communication is shown. Process types are as follows:

• Download (PC→CMC15G)

• Upload (CMC15G→PC)

• CMC15G Information

• Online monitor

• Mode change

• Online module setup

• Online date time setting

� Communication status
The contents of the currently running communication are shown. The communica-

tion contents may vary depending on the type of process.

� Progress status
The progress status of the communication is displayed in percentages and in bar

graph format.

� OK
This button is used to execute the two processes listed below.

• Download project configuration (PC→CMC15G)

• Upload project configuration (CMC15G→PC)

Clicking [OK] will start the process.

� Cancel/Close
Clicking [Cancel] will cancel the currently running communication process.

If the communication process is aborted (through cancellation or abnormal termi-

nation), this button changes to the [Close] button.

After checking the status, click [Close] to close the window.

10-7
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10-2-2 Download (PC→→CMC15G)

� Procedures
(1) Select [Download (PC→CMC15G)] under [Online] in the main menu.

>>  The Communication Status window will appear.

(2) Click [OK] to start the download process.

>>  When the communication has been completed successfully, the

Communication Status window closes.

� Description
• If any project is open, its configuration is downloaded automatically. If no pro-

ject is open, the project file selection window will appear.

• If there is an error in the configuration of the project, an error message will

appear, and downloading will not begin.

• If the CMC15G is running, a message will appear prompting the user to confirm

the transition to STOP mode. Click [OK] to change the mode of the CMC15G to

STOP and begin the download process. If you select [Cancel], the download

process will not begin.

• After the download process has been completed, a message will appear prompt-

ing the user to confirm the transition to RUN mode. Click [Yes] to change the

mode of the CMC15G to RUN. If you select [No], the CMC15G will remain in

STOP mode.
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10-2-3 Upload (CMC15G→→PC)

� Procedures
(1) Select [Upload (CMC15G→PC)] from the [Online] menu.

>>  The project file save window will appear.

(2) Select a project file to which to save the uploaded configuration.

(3) Click [OK] to close the save window. The communication status window will

appear.

(4) Click [OK] to start the upload process.

>>  When the communication has been completed successfully, the communica-

tion status window closes.

� Description
• The project file name of the project set on the CMC15G is displayed as the ini-

tial value for "file name."

• If the CMC15G is running, a message will appear prompting the user to confirm

the transition to STOP mode. Click [Yes] to change the mode of the CMC15G
to STOP and begin the upload process. If you select [Cancel], the download

process will not begin. If [No] is selected, the upload process will begin in RUN

mode. If [Cancel] is selected, the upload process will not begin.

• If the upload is started in RUN mode, it will take much longer than in STOP

mode.

• If the upload began after the mode was changed to STOP, a message will appear

prompting the user to confirm the transition to RUN mode. Click [Yes] to put

the CMC15G into RUN mode. If you select [No], the CMC15G will remain in

STOP mode.
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10-2-4 Online monitor
You can check the process status of the CMC15G or the communication status of the connected module in the

online mode.

� Screen layout

� Update
Starts monitoring the process status of each function and the communication status.

� Clear monitor information
Clears the monitor information inside the CMC15G.

� Save file
Saves the read out information to a file in CSV format.

� Copy
Moves the contents of the selected cell to the clipboard.

� Group process status
Kind

Displays the type of process. Process types are:

•  Data transmission

•  Module setup

•  Internal event

Name
Displays the group name of each function.

Exec count
Displays the number of communication execution cycles.

The range is 0 to 4294967295. If this count exceeds the high limit, it returns to

"0."

Error count
Displays the number of errors during processing.

The range is 0 to 4294967295. If this count exceeds the high limit, it returns to

"0."

Status
Displays the status of each group. Statuses are as follows:

•  Enabled

•  Disabled
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Time 1 to time 8
Displays the process time data for past eight processes (in seconds).

Overrun
"Occurred" is displayed if the startup cycle overruns and if cyclic (fixed) is

selected. In other cases, "---" is displayed.

� Connected module communication status
Connected module information

Displays the following information for connected modules:

•  CH

•  Node (node address)

•  Sub (sub-address)

•  Name

Error count
Shows the number of communication errors for each module.

Time 1 to time 8
Displays the process time data for the past eight processes (in seconds).

� Operating procedures
To start the online monitor, follow the steps below.

(1) Select [Online Monitor] from the [Online] menu.

(2) Click the [OK] button.

>>  The online monitor window will appear.

(3) To update the data, click the icon.

(4) To exit the online monitor window, click the [Close] button.

� Description
• If no project is open or if the open project does not match the configuration of

the CMC15G, the communication status window appears for the purpose of

reading monitoring information from the CMC15G. The operating speed of the

CMC15G will become slightly slower as the monitoring information is being

read.

Handling Precautions
• Information on group process status and connected module communi-

cation status is cleared when the mode is changed to RUN or when
the clear monitor status icon is clicked.
The over run column in the group process status display shows over-
runs after clearing. If you want to clear it, click the clear monitor status
icon.
Since the special SM901.0 contact (cycle overrun) relates to informa-
tion after the mode has been changed to RUN, it cannot be cleared
using the clear monitor status icon.
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10-2-5 Operation mode change
You can change the operation mode of the CMC15G.

� Screen layout

� Change to STOP
Puts the CMC15G in STOP mode.

� Change to RUN
Puts the CMC15G in RUN mode.

� Operating procedures
To change the operation mode, follow the steps below.

(1) From the [Online] menu, select [Online operation] → [Mode Change].

>>  The mode change window will appear.

(2) Click either the [RUN] or [STOP] button.

>>  A confirmation dialog box appears.

(3) If [OK] is clicked, the communication status window is displayed and the mode

is changed. If [Cancel] is clicked, the mode is not changed, and the previous

window is displayed.

>>  When communication is completed successfully, the communication status

window closes.
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10-2-6 Online module setup
Regardless of execution conditions, you can set up modules with GatewayEditor.

� Screen layout

� Update
Reads information from the CMC15G for each group which has been set up in the

module setup. The information is listed in the execution group information area.

� Execute
Executes module setup for the group selected in the execution group information

area.

� Execution group information
Lists the module setup group names read out from the CMC15G.

Select a group in order to execute it. The results of execution are also displayed.

The list is blank if the information has not been read from the CMC15G.

� Operating procedures
(1) From the [Online] menu, select [Online operation] → [Online Setup

Module].
>>  The online module setup window will appear, along with a dialog box

prompting you to confirm read-out from the CMC.

(2) Click [OK].
>>  The list of module setup groups for the CMC15G will appear.

(3) Select a group to be executed.

(4) Click the [Execute] icon.

>>  A confirmation dialog box will appear.

(5) Click [OK]. The communication status window appears and processing is then

executed. If [Cancel] is clicked instead, group processing is not executed, and

the previous window is displayed.

>>  The execution results are displayed in the execution group information area.
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� Description
• When the CMC15G is in RUN mode, a message will appear allowing you to

change to STOP mode. If the [OK] button is clicked the CMC15G enters STOP

mode and then module setup is executed. If [Cancel] is clicked, module setup is

not done.

• After module setup has been completed, there is no completion notification or

error notification.

• Online module setup is done regardless of the execution conditions and enabled

conditions set for the module setup group.

• Click the [Update] button. When the module setup group is read again, the exe-

cution results area is cleared.
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10-2-7 Online date and time setting
You can display and set up the date and time for the CMC15G.

� Screen layout

� Read CMC15G date and time
Reads the date and time from the CMC15G and shows them in the CMC15G box.

� CMC15G date and time display
Displays the date and time read from the CMC15G.

Displays "---" until the date and time are read from the CMC15G.

� PC date and time display
Displays the date and time on the personal computer.

� Date and time setting
Specify the date and time to be set for the CMC15G. By default the PC date and

time are shown. 

If the time is changed, the displayed time stops advancing.

The settable date and time range is 00:00:00 on January 1, 2000 to 23:59:59 on

December 31, 2099.

� Change the setting
The date and time set in the date and time box are written to the main unit.

� Operating procedures
• Procedures

(1) From the [Online] menu, select [Online operation] → [Online Adjust
DateTime].

>>  The online date time setting window will appear.

(2) To find out the date and time on the CMC15G, click the [Read...] button.

(3) To set a date and time different from those on the personal computer, specify

the date and time in the [Date Time] box.

(4) Click the [Write...] button.

>>  The communication status window is shown while the date and time are

being set.
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10-2-8 CMC15G information display

� Screen layout

� Update
Reads the basic information and history from the CMC15G.

� Clear history
Clears the CMC15G history.

� Save file
Saves the read out information to a file.

� Copy
Moves the contents of the selected cell to the clipboard.

� Information display
Lists information on the CMC15G in separate tabs for basic information, system

history, and communication error history.

� Operating procedures
(1) Select [CMC15G Information] from the [Online] menu.

>>  The CMC15G Information window will appear, along with a dialog box

prompting you to confirm read-out of the information.

(2) Click the [OK] button.

>>  Information on the CMC15G is shown in the information display area.

� Reading data from the CMC15G
• Procedures

(1) Click the update button.

>>  The communication status window will be displayed as information is read

from the CMC15G.
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� Saving to a CSV file

• Procedures

(1) Click the [Save file] button.

>>  The save as window will appear.

(2) Open the folder to which you wish to save the file and input a file name.

(3) Click the [Save] button.

>>  The CMC15G information is saved with the specified file name.

� Clear history
• Procedures

(1) Click the [Clear history] button.

>>  A confirmation dialog box will appear for execution of the history clear

process.

(2) Click [OK]. The communication status window will appear and the history is

cleared. If [Cancel] is clicked instead, the history log is not deleted, and the pre-

vious window is displayed.

>>  When the communication is completed successfully, the communication sta-

tus window closes.

Chapter 10. CONNECTING TO THE CMC15G WITH GATEWAYEDITOR

Save
Cancel

File name

File type



10-18

� Basic information

� Type
Displays the CMC15G type.

� Manufacturer's serial No.
Displays the manufacturer's serial No. for the CMC15G.

� IPL Version
Displays the CMC15G's IPL version. (IPL is equivalent to the BIOS on the PC.)

� F/W Version
Displays the CMC15G's firmware version. 

� Mode
Displays the mode of the CMC15G.

• STOP: STOP mode

• RUN: Project is running.

• THROUGH: Through-communication mode

� Project name
Displays the file name of the project downloaded to the CMC15G.

� Comments
Displays the comments for the project downloaded to the CMC15G. (Comments

are displayed with line feeds converted to spaces).

� Create date
Displays the date and time when the project was created.

� Modified date
Displays the date and time when the project was downloaded to the CMC15G.
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� Battery Alarm
Tells whether or not the voltage level of the CMC15G battery is lower than the

threshold value.

• Normality: Voltage level is above the threshold.

• Voltage decrease: Voltage level is below the threshold.

� Operation history

� Date and time of occurrence
Shows the date and time of the operation.

Handling Precautions
• The maximum number of records is 256. If the maximum number of

records exceeds 256, the oldest contents are overwritten with the lat-
est contents.

� Operation description
Describes the CMC15G operation. The types of operations that are logged are:

•  Power ON

•  Download config

•  Change time setting

•  Change mode
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� Communication error history

� Date and time of occurrence
Displays the date and time when the communication error occurred.

� Module in which error occurred
Displays the communication channel (CH), node address (Node), and sub-address

(Sub) for the connected module in which the communication error occurred.

� Code

Handling Precautions
• The maximum number of records is 256. If the maximum number of

records exceeds 256, the oldest contents are overwritten with the lat-
est contents.
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Module in which error
occurred

Code Error description

Illegal parameter [8010]

Fail to execute command [8013]

Receive buffer overflow [8020]

Receive buffer error [8021]

Timeout [8022]

Over-run/Framing error [8030]

Parity error [8031]

Check-sum error [8032]

Sub-address error [8033]

Node-address error [8034]

Data overflow [8080]

Fail to initialize [80A0]

Communication failure [80FF]

Other errors (code No. is indicated.) The connected device could not correctly process the message.
The code and method of error handling differs depending on the
device. Refer to the error codes described in the user's manual for
each device.

Processing was aborted or the message was discarded because
the CMC15G could not correctly receive the response. 

Even when a connected device has correctly completed message
processing, an error can be detected by the CMC15G in the
response message from the connected device.

Check the communication setup details, such as communication
speed and wiring. Additionally, an error may occur if the
communication frame is corrupted by an external disturbance,
such as electrical noise.
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� Communication error analysis
If there is only an error code in the history log for an error occurrence, follow the

steps below to locate the error.

(1) Get the channel and node where the error occurred from the communication

error history.

(2) Refer to the user's manual for the relevant module to learn what the error code

means.

(3) Locate the CMC15G configuration sheet in which the error occurred using the

GatewayEditor's Online monitor.

Note
The following shows an example of error codes for Yamatake's modules:

� Common to all modules

� DMC10
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Code Error description Comment

0099 Command is undefined. End code is returned and the message processing
Normally, this error does not occur while configur- is not executed.
ing the CMC15G.
It may occur if the communication frame is corrupt-
ed by external disturbance, such as electrical noise.

Code Error description Comment

0022 Written data is out of range. The relevant word address is skipped and process-
ing continues.

0023 Writing is impossible because of instrument settings The relevant word address is skipped and process-
or external conditions. ing continues.

0040 The number of read words is abnormal. End code is returned and the message processing
is not executed.

0041 Conversion error due to out-of-range word address. End code is returned and the message processing
Address is outside the -32768 to +32767 range. is not executed.

0042 Data value is out of range / data error / single word Processing is executed up to the relevant word
range exceeded. address. However, subsequent processing is not

done.
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� SDC45

� SDC15, SDC25/26, SDC35/36
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Code Error description Comment

0010 Numeric value conversion error Conversion error.
• There are 7 or more numerical digits Processing is stopped if a range error occurs. 
• Numeric value other than 0 starts with "0" Processing is executed up to the error. 
• Conversion result is outside the 65535 to -65536
range.

• Some other incorrect non-integer expression

0022 The value of the written data is beyond the setting The relevant word address is skipped and process-
range. ing continues.

0023 Writing is impossible due to instrument settings or The relevant word address is skipped and process-
external instrument conditions. ing continues.

Reading/writing is impossible while the communica- End code is returned and the message processing
tion loader is locked. is not executed.

0040 The number of read/written words is abnormal. End code is returned and the message processing
is not executed.

0041 The data address is out of range. End code is returned and the message processing
• The data address is outside the allowable range is not executed.

of 256 to 65534.

0042 Data value is outside the setting range of -32769 to Processing is executed up to the relevant data
32768. address. However, subsequent processing is not

done.

Code Error description Comment

0010 • Numeric value conversion error. End code is returned and message processing is 
• Apart from commands, there are characters other not executed.
than '0' to '9' and 'A' to 'F' in the application layer.

• The message length of the application layer is 
illegal.

• There is a character other than '00' in the sub-
command of the RU/WU command.

0021 A data address that is not in the read command is The read-out value at the relevant data address
included. is set to "0" and is returned.

A data address that is not in the write command is The relevant data address is skipped and process-
included. ing continues.

0022 A read-out value other than those at data address- The read-out value at the relevant data address is
es 8000 to 7FFF (decimal -32768 to + 32767) is returned as 8000 (decimal -32768) or 7FFF 
included in the read-out command. (decimal +32767).

Write value at a data address other than the The relevant data address is skipped and process-
setting range is included in the write command. ing continues.

0023 An included data address cannot be read due to The read-out value at the relevant data address
instrument conditions or communication lock. is set to "0" and is returned.

An included data address cannot be written due to The relevant data address is skipped and process-
instrument conditions or communication lock. ing continues.

0040 The number of read/write data records is illegal. End code is returned and the message processing
is not executed.
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10-2-9 Upgrading the system
To upgrade the system, new system files are downloaded from the PC to the CMC15G.

� Automatic update
When project files are downloaded to the CMC15G, the system files on the

CMC15G and on the PC are compared. If the CMC15G's system files are older, a

confirmation message for system file update appears.

If [Yes] is clicked, the project file is downloaded after all system files have been

updated. If [No] is clicked, the project file is downloaded without updating the sys-

tem files. Clicking [Cancel] exits the dialog without doing anything.

(1) Disconnect the modules from the CMC15G or turn OFF the power.

(2) Open a project to be downloaded to the CMC15G.

(3) Select [Online]→[Download PC -> CMC15G].

>>  The communication status window will appear.

(4) Click the [OK] button.

>>  The system files on the CMC15G are compared to those on the PC. If the

CMC15G's system files are older, a confirmation message for system file

update appears.

(5) Click the [Yes] button. After all systems have been updated, download the pro-

ject file.

Handling Precautions
• If the system files installed on the CMC15G and on the PC are the

same version, no files are updated.

• If [Cancel] is clicked in the message window, the process is cancelled.

• If you update the system files without disconnecting the modules from
the CMC15G, the update process may fail. If this occurs, reset the
CMC15G once or turn OFF the power and turn it ON again to restart
the update process.

� Manual update
In addition to a system file update triggered by downloading a project, an update

can be done manually.

Section 11-3, Updating the CMC15G system files.

Chapter 10. CONNECTING TO THE CMC15G WITH GATEWAYEDITOR





Chapter 11 TOOLS
11  -  1 Environment Configuration

� Communication configuration
You can configure the connections between the CMC15G and PC.

� Interface selection
Select a communication interface on the PC used to connect the CMC15G.

• USB

• Serial Port

The initial value is "USB."

� Communication port selection
If you check [Serial Port] as the interface selection, select the COM port connected

to the CMC15G. The initial value is the port that is found first. If no COM port is

found, the initial value is blank.

Handling Precautions
• If you start communications before a valid communication interface is

found, an error message will appear. Only valid COM ports on the PC
are displayed in the drop-down list for port selection.

• Procedures

(1) Select [Tool] → [Environment].
>> The environment configuration window will appear.

(2) Select an interface.

(3) If [Serial Port] is checked in step (2), select a COM port.

(4) Click the [OK] button.

11-1

Communication port selection

Interface selection



11  -  2 Changing the Target Model

11-2

To change the target model of the project currently being edited, follow the steps below.

(1) Select [Tool] → [Change Target Model].
>> The dialog box will appear for confirmation of target model change.

(2) Click [OK].
>> The target model is changed.

Handling Precautions
• If the model is changed from "recording (CMC15GD01)" to "standard

(CMC15GS01)," the contents of the trend settings, data log, and event
log are cleared completely.

• If [Cancel] is clicked in the dialog box, no change is made.

• If configuration sheets are open, all sheets are closed.

Chapter 11. TOOLS



11  -  3 Updating the CMC15G System

To manually change the CMC15G system version, follow the steps below.

(1) Disconnect the modules from the CMC15G or turn OFF the power.

(2) Select [Tool] → [Update system on CMC15G].
>>  The communication status window will appear.

(3) Click [OK] to begin a check of the system version.

>> A message about the system update of the PC will appear.

(4) Click [OK]. The system files are then transmitted to the CMC15G.

Handling Precautions
• Do not turn OFF the power to the CMC15G while the system files are

being updated. Doing so may cause a malfunction.

• If the system files installed on the CMC15G and on the PC are the
same version, no files are updated.

• If [Cancel] is clicked in the message window, the process is cancelled.

• If a project has been downloaded to the CMC15G, the system files are
updated after the project has been read. The project is automatically
downloaded after the system files have been updated.

• If you update the system files without disconnecting the modules from
the CMC15G, the update process may fail. If this occurs, reset the
CMC15G once or turn OFF the power and turn it ON again to restart
the update process.

11-3
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Chapter 12 CONTACTS AND REGISTERS INSIDE THE CMC15G

The following internal device areas are available on the CMC15G. The CMC15G can refer to special internal con-

tacts and registers and can read/write data using external serial commands.

CMC15G Multifunction Gateway Communication Controller User's Manual for Communication
Connections, CP-SP-1278E (for details on serial commands)

� List of devices

Handling Precautions
• The digital signal input/output bus (BM) is word data. One word is

equivalent to one point on the input/output bus. If the value is not 0,
the point is turned ON. If the value is 0, the point is turned OFF.

12-1

Device name Device Read Write Communication Size Backup Initialization

Read Write

Internal event area EM000.0 to EM001.3 ❍ × ❍ × 20 bits None Turned OFF upon
change to RUN.

Digital signal input/ BM00000 to BM00003 ❍ ❍ ❍ × 4 bits None Turned OFF upon 
output bus change to STOP.

User contact area NM0000.0 to NM9999.F ❍ ❍ ❍ ❍ 10,000 words None Turned OFF at
startup and upon
change to RUN.

User resister area NR00000 to NR32767 ❍ ❍ ❍ ❍ 32,768 words None Turned OFF at
startup and upon
change to RUN.

User backup contact SM000.0 to SM899.F ❍ ❍ ❍ ❍ 900 words Yes When project is 
area downloaded.

User backup register SR00000 to SR32767 ❍ ❍ ❍ ❍ 32,768 words Yes When project is 
area downloaded.

Special contact area SM900.0 to SM999.F ❍ × ❍ × 100 words Yes See page 12-2.

Special register area SR90000 to SR99999 ❍ × ❍ × 10,000 words Yes See page 15-3.
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� Special contacts
Special contacts show the internal status of the CMC15G, such as the occurrence

of an error. You can read a value from a special contact, but cannot write a value to

it.

Handling Precautions
• If you use a special contact as a trigger device, do not enable trigger

device initialization. If you do, trigger device initialization will fail
because writing is not possible, and processing will not be executed.

• Special contact SM901.0 (cycle overrun) is not cleared even if the
clear monitor information command is executed in the Online Monitor
window.
Since the overrun display function of the group process status displays
the history after the monitor information clear has been executed, it is
cleared when the clear monitor information command is executed.

Chapter 12. CONTACTS AND REGISTERS INSIDE THE CMC15G

Device name Device Read Write Communication Operating detail Initialization

Read Write

CH1 Communication error SM900.7 ❍ × ❍ × Communication error on CH1. Initially OFF

CH2 Communication error SM900.8 ❍ × ❍ × Communication error on CH2. Initially OFF

CH3 Communication error SM900.9 ❍ × ❍ × Communication error on CH3. Initially OFF

CH4 Communication error SM900.A ❍ × ❍ × Communication error on CH4. Initially OFF

Battery alarm SM900.B ❍ × ❍ × Low battery voltage Constantly updated.

Cycle overrun SM901.0 ❍ × ❍ × Overrun during fixed cycle processing. Turned OFF at
startup and upon
change to RUN.

Running SM902.0 ❍ × ❍ × ON while running. Turned OFF upon
change to STOP.

ON after one scan SM902.1 ❍ × ❍ × Turned ON after group processing Turned OFF upon
begins. change to RUN.

OFF after one scan SM902.2 ❍ × ❍ × Turned OFF after group processing Turned ON upon
begins. change to RUN.

Always ON SM905.0 ❍ × ❍ × Always ON Initially OFF

1 s clock SM905.1 ❍ × ❍ × Turned ON and OFF repeatedly Initially OFF
at 1 s intervals.

5 s clock SM905.2 ❍ × ❍ × Turned ON and OFF repeatedly Initially OFF
at 5 s intervals.

10 s clock SM905.3 ❍ × ❍ × Turned ON and OFF repeatedly Initially OFF
at 10 s intervals.

Always OFF SM905.F ❍ × ❍ × Always OFF Initially OFF
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� Special registers
The special register area is where configuration information inside the CMC15G
and information on communication errors is saved. It is a read-only area.

Chapter 12. CONTACTS AND REGISTERS INSIDE THE CMC15G

Device name Device Read Write Communication Operating detail Initialization

Read Write

Year SR90143 ❍ × ❍ × Shows the last two digits of the year Constantly updated.
Range: (200)0 to (20)99.

Month SR90144 ❍ × ❍ × Range: 1 to 12 Constantly updated.

Day SR90145 ❍ × ❍ × Range: 1 to 31 Constantly updated.

Day of the week SR90146 ❍ × ❍ × Value: 0 to 6 Constantly updated.
0: Sun.
1: Mon.

6: Sat.

Hour SR90147 ❍ × ❍ × Range: 0 to 23 Constantly updated.

Minute SR90148 ❍ × ❍ × Range: 0 to 59 Constantly updated.

Second SR90149 ❍ × ❍ × Range: 0 to 59 Constantly updated.
...





Chapter 13 MAINTENANCE

� Replacing the battery

Handling Precautions
• If the POWER indicator indicates low backup battery voltage, replace the

battery as soon as possible. Replacement of the battery within one
month of the first indication of low voltage is recommended.

• When replacing the battery, strictly observe the following points:

•  Supply power for 10 minutes or longer before turning OFF the power.

•  Complete the battery replacement work within 15 minutes.
If the battery replacement work is not done within this period of time,
the clock data, backup area, and/or history data may be lost.

•  Use Yamatake replacement battery No. 81446431-001.

� Replacement procedure
(1) Back up all CMC15G data to the PC using GatewayEditor.

(2) Supply power to the CMC15G for 10 minutes or longer. Then turn OFF the

power.

(3) Remove the CMC15G from the base.

(4)Slide the metal fastener in the direction indicated by the arrow shown in the fig-

ure and disconnect the battery cable.

(5) Disconnect the battery cable connector from printed circuit board A to remove

the battery.

(6) Connect the connector of the replacement battery to the connector on printed

circuit board A.

(7) Secure the battery cable with the metal fastener and push the metal fastener

against printed circuit board B until a click is heard. Push in the cable to the far

portion of the metal fastener where possible. This ensures easy assembly.

13-1

CAUTION
Do not throw a used battery into the fire or into the garbage. Dispose of it properly, following
local regulations.

Do not short-circuit the battery or allow it to get wet. If the battery is short-circuited, it may heat
up or ignite.

Battery

Metal fastenerBattery cable

(4)

PCB A

PCB B

Connector
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(8) Mount the CMC15G on the base.

(9) Check with GatewayEditor that the clock data is correct. If necessary, correct

the clock data and then transmit the data that was backed up to the PC in step (1)

to the CMC15G.

� Disposal
When discarding, remove the battery and dispose of both the product

and the battery as industrial waste, following local regulations.

Chapter 13. MAINTENANCE

EU



Chapter 14 SPECIFICATIONS

� Specifications

14-1

Item Specifications

Communications CH1 RS-232C, full duplex (half duplex protocol), cable length 15 m or less,
D-Sub 9-pin, Max. transmission speed 115.2 kbps

CH2 RS-485, 5-wire system full duplex (half duplex protocol), cable length
500 m or less, connector (5-pin of 7-pin connector), Max. transmission
speed 115.2 kbps

CH3 RS-485, 3-wire system half duplex, cable length 500 m or less, con-
nector (3-pin of 7-pin connector), Max. transmission speed 19.2 kbps

CH4 RS-485, 3-wire system half duplex, cable length 500 m or less, screw
terminals on the base, Max. transmission speed 38.4 kbps

USB USB 2.0-based full speed (12 Mbps) mini-B, 5-pin

Digital signal Number of I/O bus 4 points
I/O bus Function Outputs the logical add (OR) of the same bus event outputs from each

DMC10.

General Rated power voltage 24 Vdc
specifications Operating power voltage 21.6 to 26.4 Vdc

Power consumption 3 W or less

Insulation resistance Min. 20 MΩ by 500 Vdc megger (between each I/O terminals and 24
Vdc power terminals)

Dielectric strength 500 Vac for 1 min. (between case and 24 Vdc power terminals)

Isolation All communications lines are isolated from power lines. Individual
communications channels are not isolated from each other. Individual
EV buses are not isolated from each other, but are isolated from
communications.

Built-in clock accuracy Within ± 40s per month (reference value at 25 ˚C)

Memory backup Min. 5 years (at 25 ˚C)

Operating condition Ambient temp.: 0 to 50 ˚C, Ambient humidity: 30 to 90 %RH

Transport/storage Ambient temp.: –20 to +70 ˚C, Ambient humidity: 10 to 95 %RH
conditions Vibration resistance: Max. 4.9 m/s2

Impact resistance: Max. 392 m/s2 for screw mount
Max. 196 m/s2 for DIN rail mount

Package drop test: Drop height 60 cm, free fall

Screw tightening torque Power terminals and CH4 communication terminals : 0.8 to 1.0 N•m

Mounting DIN rail mount or screw mount

Materials Mask, Case, Base: Polycarbonate

Color Mask: Navy blue, Case: Light gray, Base: Light gray

Mass Approx. 200 g

Applicable standard EN61326

Accessories User's Manual (No.CP-UM-5463E) 1 piece

CH2, CH3 Communication connector 1 piece

Maintenance parts Battery Model No.: 81446431-001

Software Smart Loader Package (The GatewayEditor) Model No.: SLP-G15J50
Smart Loader Package (The LogViewer) Model No.: SLP-G15LGV
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� External dimensions

Chapter 14. SPECIFICATIONS
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Chapter 15 TROUBLESHOOTING

� Diagnosis using the indicator lights
The CMC15G's indicator lights notify the user if an error occurs.

� POWER indicator

� ALARM indicator

� RUN indicator

� REC indicator

15-1

ALM

RECRUN

POWER

CH1 RS-232C

POWER indicator:
   Green when power is ON.
   Orange if battery voltage is low.

RUN indicator:
   Green for RUN mode.
   Flashing green for loader 
   through-mode.

ALARM indicator:
   Red if self-diagnosis finds an error.

REC indicator:
   Lit during trend recording.
   Flashing if there is a capture.

Status Meaning Corrective action

Green CMC15G power is ON. —

Off CMC15G power is OFF. Turn ON the power.

Orange Backup battery voltage is low. Replace the backup battery.
Chapter 13, Maintenance

Status Meaning Corrective action

Off The CMC15G is running normally. —

Red An error occurs in the self- If the ALARM indicator is lit red,
diagnosis. turn OFF the power and then turn

it ON again, or reset the CMC15G
with the RESET button. 
If the alarm still appears, contact a
Yamatake salesperson.

Status Meaning Corrective action

Off CMC15G functions have stopped. To change to RUN mode, use the
GatewayEditor.

10-2-5, Operation mode
change (page 10-12)

Green CMC15G functions are running. —

Flashing The controller loader (SLP, etc.) is To switch from through-communi-
green doing loader through-communica- cation mode to RUN mode, run

tion with a slave station through ThroughComm.exe.
the CMC15G. 7-6, Loader through-

communication (page 7-10)

Status Meaning Corrective action

Off Not recording. —

Green Trend is being recorded. —

Flashing The captured trends function is —
green running after a trigger occurred.
(1 s 
intervals)

Flashing Captured trends function is run- —
green ning but capture memory is full.
(200ms 
intervals)
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� Error diagnosis using the CH1 to CH4 indicators
The indicators show whether there was a communication error.

Four indicators corresponding to the COM ports to which the modules are connect-

ed indicate the communication status of each module.

* For example, a communication request occurs when there is a periodic data

transmission or when a trigger device initiates module setup. Additionally, since

the CMC15G monitors trigger devices periodically, if a host station device is set

as a trigger device, it is normal for the indicator of the channel connected to the

host station to be flashing frequently.

Chapter 15. TROUBLESHOOTING

CH

LOADER

4

3

2

1

RS 485

CH1 communication status

CH2 communication status

CH3 communication status

CH4 communication status

Status Meaning Corrective action

Not lit No communication If the indicator is not lit even
though there is a communication
request*, the communication
parameters may be incorrect.
Using GatewayEditor, check the
communication parameters for the
target channel.

Flashing Communicating —
green

Orange No response, or error in received Any of the following may be the 
message cause:

•  The cable is connected incorrectly.
•  The communication setup for 

the module (node address, 
transmission speed, parity, etc.) 
is incorrect.

•  The communication parameters 
(data address, data area, etc.) 
are incorrect. Depending upon 
the device, mode, and condi-
tions, it may not be possible to 
write data.

Using the GatewayEditor's Online
monitor, identify the module with
the communication error, and
check the wiring and the
communication configuration and
parameters.

10-2-4, Online monitor (page
10-10)
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� Corrective actions in case of an error occurs

Chapter 15. TROUBLESHOOTING

Context Symptom Cause Corrective action
(activity)

Installation Indicators EV1 to EV4 start Low voltage due to insufficient Increase the supply power in order
flashing when the power is supply power. to maintain the voltage necessary 
turned ON. for operation.
POWER indicator does not If the power supply and wiring are Contact a Yamatake sales office or
light up green when the correct, the CMC15G may be faulty. dealer.
power is turned ON.

Connection USB connection with the USB drivers are not installed Run setup.exe from the usb 
with personal CMC15G does not work. correctly. directory  (default location is 
computer C:\Program Files\SLP\SLPG15\usb),

located at the installation
destination for GatewayEditor's
USB drivers.
The USB cable should not be
connected to the CMC15G while the
installer is running.

Multiple CMC15G units cannot be Connect only one CMC15G to the
connected to the personal computer. personal computer.
The connected units will not com-
municate properly, or unexpected 
errors will occur.

Installation fails because This error occurs if the CMC15G is Specify the vcp1 directory (default 
the file cannot be found by connected through the USB con- location is C:\Program
the Windows New Hard- nector when the installer is running. Files\SLP\SLPG15\usb\vcp1) at
ware Wizard. the GatewayEditor installation

destination as the location of the
installation files.

Regular CH1 to CH4 indicators are The wiring may be incorrect. Check the wiring again while 
operation orange. The terminating resistor may not be referring to Chapter 4, WIRING.

connected correctly. Additionally, carefully check the
following points:
• Always connect the signal ground.
If not connected, communication
may not be reliable.

• Connect a terminating resistor
(150 Ω, 1/2W) to CH2.

• Do not connect any external
terminating resistor, since the
equivalent of a terminating resistor
is built into CH3 and CH4. Do not
connect a resistor even if the other
units connected to the CMC15G
require a terminating resistor.

The communication parameters or • Check settings such as transmis-
the node address of the connected sion speed and parity.
module may be incorrect. • Check that the address of the con-

nected module matches the setting.
• Check especially that there are not

duplicate node addresses.
The CMC15G cannot be The communication disconnection Check the communication discon-
connected to the DMC10 switch on the base of the CMC15G nection switch on the base of the
on CH4. or DMC10 may not be set at CMC15C and DMC10.

"CONNECT."
There is no communication If the RUN indicator is lit, the Check the startup delay setting.
even though a project was problem may be that a startup delay 
downloaded. has been set.
There is always a com- If any module is set to be started Delay the communication start 
munication error when the after the CMC15G, a communica- time of the CMC15G using the
power is turned ON. tion error occurs. startup delay setting.
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Context Symptom Cause Corrective action
(activity)

Regular Data transmission or If the trigger is a write-prohibited Go to [System Config] → [Option] 
operation module setup for which a device and trigger device initializa- → [Initialize] and turn OFF trigger

trigger was set did not start tion is enabled, the trigger cannot device initialization, or specify a
up. be executed. different trigger device which is

write-enabled.
If the same trigger is set for multiple When the same trigger is used for
groups and [Option Configuration] multiple groups, do not set [Option
→ [Initialize] tab → [Initialize trigger Configuration] → [Initialize ] tab →
device] is ON, depending on the [Initialize trigger device] ON.
timing, the trigger device may be
turned OFF right away, so that it
does not start trigger is not started
up.
If a special contact is used as a When a special contact is used as
trigger, initialization of the trigger a trigger, do not enable trigger
device will fail because writing is device initialization.
not possible. Therefore processing
is not executed.

In the communication error When an error is returned from a Follow the steps below to locate the 
history, an error is identified module connected to the CMC15G, error.
only by an error code. an error code is shown. • Get the channel and node where

This kind of error occurs if the set- the error occurred from the com-
ting or model No. on the connected munication error history.
module is incorrect. • Refer to the user's manual for the
For example: The file register size relevant module to learn what the
is out of  range, or a value beyond error code means.
the writable range is written, or a • Locate the CMC15G configuration
value is written to a write-prohibited sheet in which the error occurred
area. using the GatewayEditor's Online

monitor.
The retry-over error some- A one-time communication load Cyclic (Auto) functions at the fastest
times appears in the com- may be too large for the CMC15G speed, according to the priority.
munication error history. to receive all of the data correctly. To get control of the load, set the

This error may happen if all settings data not needing a fast update
are set to "Cyclic (Auto)." cycle to "Cyclic (Fixed)" to slow

down its cycle.
Completion notification An error that occurs while writing to To check whether or not a com-
failed but there was no the completion notification device munication error has occurred,
notification of the error. is not indicated by error notification. select [Online] → [CMC15G

Information] → [Communication
Error History].

There was no  communica- Communication error notifications To check whether or not a com-
tion error notification for an are issued if there is an error with munication error has occurred,
extended function. a trigger. select [Online] → [CMC15G 

In the case of a  constant error, Information] → [Communication
such as faulty wiring, notification is Error History].
issued only once.
Also, it may be that the module in 
which the communication error 
occurred was reset correctly, but 
the specified bit on the host station 
was not turned OFF.

Gateway- There are floating point Values are rounded to a value Use a value within the usable 
Editor numerical values that can- within the handling range. range.

not be input. The effective ranges for floating 
point numbers are:
-3.402823E+38 to -1.175494E-38, 
0, and 
+1.175494E-38 to +3.402823E+38.

CMC15G operating If the [Clear history] button is click- After clicking [Clear history], click
history or communication ed, the history inside the the [Refresh] button to update the 
error history cannot be CMC15G is cleared. display.
cleared. The history displayed on Gateway-

Editor is not cleared and the pre-
viously read information is display-
ed as is.
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Context Symptom Cause Corrective action
(activity)

Gateway- The group order cannot be The order cannot be changed with Move the selection sheet up or 
Editor changed. the mouse. Change the order from down as follows:

the [Edit] menu or toolbar. • From the menu:
[Edit] → [Move up], [Edit] → [Move 
down]

• From the toolbar:
[↑] button, [↓]button

• From the keyboard:
[Ctrl] + [↑] keys, [Ctrl] + [↓] keys

General Data collection does not If the enabled-disabled setting If the REC indicator is not green
logging start. results in "disabled" status, the while the continuous trend or
functions data collection is not started. captured trends function is running,

the enabled-disabled setting has
disabled the process, or other set-
tings are incorrect.
Check the cycle(s) and enabled-dis-
abled setting.
Check also the trigger device in the
captured trends or data log.

All data is not collected The interval for data collection is Extend the collection interval.
completely. too short for the volume of data. If a CMC15G communication error

occurred, it can be checked using
the online monitor or communica-
tion error history.

All data is not collected If a power failure occurs, data is Check the operation history in
completely. handled discontinuously. GatewayEditor to see whether a

power ON (power turned OFF, and
then turned ON again) occurred.

When downloading with If the volume of internal memory Adjust the settings on the basis
GatewayEditor, the backup used by all logging functions of all groups or logging functions
memory size exceeded the exceeds the capacity of the so that internal memory usage
high limit, and the trans- CMC15G, downloading is not does not exceed the maximum
mission of configuration executed. level.
data to the CMC15G was The usage volume is indicated by
stopped. the color of the backup memory

usage ratio display in Gateway-
Editor. If the color is red, the mem-
ory usage exceeds the capacity.
Additionally, you can check the
number of bytes set for the memory
under the project information in
GatewayEditor.

Captured Even though triggers for all After a trigger starts up but before Change the conditions for trigger
trends captures are turned ON, its data has been saved, there is occurrence using an internal event
function the capture memory does another trigger. on the PLC or CMC15G.

not fill up. Triggers that are activated before Also, if you increase the number of
data saving is complete are ignored. records saved after the initial trig-

ger, more data can be obtained
even though the second trigger is
ignored.

LogViewer The real-time monitor The real-time monitor does not save Change the file name, remaining
stopped. data automatically if any of the capacity of the disk, or file path so

following conditions occurs: that the data is saved automatically.
• A file with the same name already
exists.

• There is insufficient space at the
file destination.

• The number of characters in the
full path name for the file exceeds
255 characters.
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